
UNO 2.1



Preface
Notice
The company reserves the right to revise this publication or to change its contents without notice. Information
contained herein is for reference only and does not constitute a commitment on the part of the manufacturer or
any subsequent vendor. They assume no responsibility or liability for any errors or inaccuracies that may appear
in this publication nor are they in anyway responsible for any loss or damage resulting from the use (or misuse)
of this publication.
This publication and any accompanying software may not, in whole or in part, be reproduced, translated, trans-
mitted or reduced to any machine readable form without prior consent from the vendor, manufacturer or creators
of this publication, except for copies kept by the user for backup purposes.
Brand and product names mentioned in this publication may or may not be copyrights and/or registered trade-
marks of their respective companies. They are mentioned for identification purposes only and are not intended
as an endorsement of that product or its manufacturer.
©January 2012

Trademarks
Intel, Celeron, and Intel Core are trademarks/registered trademarks of Intel Corporation.
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Preface
R&TTE Directive
This device is in compliance with the essential requirements and other relevant provisions of the R&TTE Direc-
tive 1999/5/EC.

This device will be sold in the following EEA countries: Austria, Italy, Belgium, Liechtenstein, Denmark, Lux-
embourg, Finland, Netherlands, France, Norway, Germany, Portugal, Greece, Spain, Iceland, Sweden, Ireland,
United Kingdom, Cyprus, Czech Republic, Estonia, Hungary, Latvia, Lithuania, Malta, Slovakia, Poland, Slov-
enia.

EuP-Standby and Off Mode Power Consumption Statement:
The figures below note the power consumption of this computer in compliance with European Commission (EC)
regulations on power consumption in off mode or standby mode:

• Standby Mode < 2W
• Off Mode < 1W
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Preface
CE Marking
This device has been tested to and conforms to the regulatory requirements of the European Union and has at-
tained CE Marking. The CE Mark is a conformity marking consisting of the letters “CE”. The CE Mark applies
to products regulated by certain European health, safety and environmental protection legislation. The CE Mark
is obligatory for products it applies to: the manufacturer affixes the marking in order to be allowed to sell his
product in the European market.

This product conforms to the essential requirements of the R&TTE directive 1999/5/EC in order to attain CE
Marking. A notified body has determined that this device has properly demonstrated that the requirements of the
directive have been met and has issued a favorable certificate of expert opinion. As such the device will bear the
notified body number 0560 after the CE mark.

The CE Marking is not a quality mark. Foremost, it refers to the safety rather than to the quality of a product.
Secondly, CE Marking is mandatory for the product it applies to, whereas most quality markings are voluntary.
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Preface
FCC Statement
(Federal Communications Commission)
You are cautioned that changes or modifications not expressly approved by the party responsible for compliance
could void the user's authority to operate the equipment.

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part
15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in
a residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not in-
stalled and used in accordance with the instructions, may cause harmful interference to radio communications.
However, there is no guarantee that interference will not occur in a particular installation. If this equipment does
cause harmful interference to radio or television reception, which can be determined by turning the equipment
off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

• Re orient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the service representative or an experienced radio/TV technician for help.

Operation is subject to the following two conditions:

1. This device may not cause interference.

And

2. This device must accept any interference, including interference that may cause undesired operation of the 
device.
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Preface
FCC RF Radiation Exposure Statement:

1. This Transmitter must not be co-located or operating in conjunction with any other antenna or transmitter.

2. This equipment complies with FCC RF radiation exposure limits set forth for an uncontrolled environment. This 
equipment should be installed and operated with a minimum distance of 20 centimeters between the radiator 
and your body.


Warning

Use only shielded cables to connect I/O devices to this equipment. You are cautioned that changes or modifications not ex-
pressly approved by the manufacturer for compliance with the above standards could void your authority to operate the
equipment.
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Preface
IMPORTANT SAFETY INSTRUCTIONS
Follow basic safety precautions, including those listed below, to reduce the risk of fire, electric shock, and injury
to persons when using any electrical equipment:

1. Do not use this product near water, for example near a bath tub, wash bowl, kitchen sink or laundry tub, in a wet 
basement or near a swimming pool.

2. Avoid using this equipment with a telephone line (other than a cordless type) during an electrical storm. There 
may be a remote risk of electrical shock from lightning.

3. Do not use the telephone to report a gas leak in the vicinity of the leak.
4. Use only the power cord and batteries indicated in this manual. Do not dispose of batteries in a fire. They may 

explode. Check with local codes for possible special disposal instructions.
5. This product is intended to be supplied by a Listed Power Unit (Full Range AC/DC Adapter – AC Input 100 - 

240V, 50 - 60Hz, DC Output 19V, 4.74A (90 Watts).

This Computer’s Optical Device is a Laser Class 1 Product
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Preface
Instructions for Care and Operation
The computer is quite rugged, but it can be damaged. To prevent this, follow these suggestions:

1. Don’t drop it, or expose it to shock. If the computer falls, the case and the components could be damaged.

2. Keep it dry, and don’t overheat it. Keep the computer and power supply away from any kind of heating ele-
ment. This is an electrical appliance. If water or any other liquid gets into it, the computer could be badly dam-
aged.

3. Avoid interference. Keep the computer away from high capacity transformers, electric motors, and other 
strong magnetic fields. These can hinder proper performance and damage your data.

4. Follow the proper working procedures for the computer. Shut the computer down properly and don’t forget 
to save your work. Remember to periodically save your data as data may be lost.

5. Take care when using peripheral devices.
VII



Preface
Power Safety
The computer has specific power requirements:

• When you want to unplug the power cord, be sure to disconnect it by the plug head, not by 
its wire.

• Make sure the socket and any extension cord(s) you use can support the total current load 
of all the connected devices.

• Before cleaning the computer, make sure it is disconnected from any external power sup-
plies.

Do not plug in the power 
cord if you are wet.

Do not use the power cord if 
it is broken.

Do not place heavy objects 
on the power cord.


Power Safety 

Warning

Before you undertake
any upgrade proce-
dures, make sure that
you have turned off the
power, and discon-
nected all peripherals
and cables (including
telephone lines and
power cord). 
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Preface
Cleaning
Do not apply cleaner directly to the computer, use a soft clean cloth. 
Do not use volatile (petroleum distillates) or abrasive cleaners on any part of the computer.

Servicing
Do not attempt to service the computer yourself. Doing so may violate your warranty and expose you and the
computer to electric shock. Refer all servicing to authorized service personnel. Unplug the computer from the
power supply. Then refer servicing to qualified service personnel under any of the following conditions:

• When the power cord is damaged or frayed.
• If the computer has been exposed to any liquids.
• If the computer does not work normally when you follow the operating instructions.
• If the computer has been dropped or damaged (do not touch the poisonous liquid if the LCD panel breaks).
• If there is an unusual odor, heat or smoke coming from your computer.


Removal Warning

When removing any cover(s) and screw(s) for the purposes of device upgrade, remember to replace the cover(s) and
screw(s) before restoring power to the system.

Also note the following when the cover is removed:

• Hazardous moving parts.
• Keep away from moving fan blades.
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Preface
Ergonomics
We designed your Multimedia PC system to be functional as well as attractive. To get most out of it, here are
some suggestions on how to position and use the computer:

• The top third of the LCD (screen) should be at eye-level or slightly below.

• The LCD should be at least 18"/45cm. directly in front of you.

• If the screen resolution makes you strain to read, then adjust the resolution to something more comfortable (see “Video 
Features” on page 1 - 26).

• Angle the LCD (see “Tilting & Adjusting the LCD Screen Height” on page 1 - 7) so that it doesn’t reflect any light 
into your eyes.

• Use a chair which offers good back support (especially lower-back). The seat should allow your feet to rest flat on the 
floor or on a footrest directly in front of you.

• If possible, illuminate your work area with natural daylight or use a steady-glowing (non-flickering) light source.

• Place the keyboard and mouse so that your arms are at your sides and your forearms are roughly parallel to the floor. 
Your wrists should flex slightly downward as you work. Your neck and shoulders should also be relaxed.

• Take a break from the computer. Get up, stretch, flex your wrists, walk about, and look at something else for about 10 
minutes every hour.
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Preface
Lighting
Proper lighting and comfortable display viewing angle can reduce eye strain and muscle fatigue in your neck and
shoulders.

• Position the display to avoid glare or reflections from overhead lighting or outside sources of light.
• Keep the display screen clean and set the brightness and contrast to levels that allow you to see the screen clearly.
• Position the display directly in front of you at a comfortable viewing distance.
• Adjust the display-viewing angle to find the best position.

LCD Screen Care
To prevent image persistence on LCD monitors (caused by the continuous display of graphics on the screen for
an extended period of time) take the following precautions:

• Set the Windows Power Plans to turn the screen off after a few minutes of screen idle time.
• Use a rotating, moving or blank screen saver (this prevents an image from being displayed too long).
• Rotate desktop background images every few days.
• Turn the monitor off when the system is not in use.


Carrying the Computer

We strongly recommend using both hands to move the computer (one hand gripping the handle area and the other grip-
ping the computer) to avoid accidentally dropping it. Be careful that objects such as belt buckles etc. do not scratch the
screen while it is being carried.
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Preface
Wall Mounting Information
The computer may be mounted on a wall for display. The system meets VESA MIS-D Standard (100mm *
100mm) for wall mounting. However if you intend to wall mount the system please contact your service center
for information in order to avoid personal injury, or damage to the computer.
XII
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Quick Start Guide 1
Chapter 1: Quick Start Guide

Overview
This Quick Start Guide is a brief introduction to the basic features of your computer, to navigating around the
computer and to getting your system started. The remainder of the manual covers the following:

• Chapter 2 A guide to using some of the main features of the computer e.g. the storage devices (hard disk, 
optical device, Multi-in-1 card reader, ExpressCard/34/54) Audio & Printer.

• Chapter 3 The computer’s power saving options.
• Chapter 4 The installation of the drivers and utilities essential to the operation or improvement of some of the 

computer’s subsystems.
• Chapter 5 An outline of the computer’s built-in software or BIOS (Basic Input Output System).
• Chapter 6 Instructions for upgrading your computer.
• Chapter 7 A quick guide to the computer’s PC Camera, Wireless LAN, Bluetooth & WLAN Combo and 

Intel modules (some of which may be optional depending on your purchase configuration).
• Chapter 8 A troubleshooting guide.
• Appendix A Definitions of the interface, ports/jacks which allow your computer to communicate with external 

devices.
• Appendix B Information on the Intel video driver controls.
• Appendix C The computer’s specification.
• Appendix D Information related to the Windows 7 operating system.
Overview 1 - 1
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Advanced Users
If you are an advanced user you may skip over most of this Quick Start Guide. However you may find it useful
to refer to “What to Install” on page 4 - 1, “BIOS Utilities” on page 5 - 1 and “Upgrading The Computer” on
page 6 - 1 in the User’s Manual. You may also find the notes marked with a  of interest to you.

Beginners and Not-So-Advanced Users
If you are new to computers (or do not have an advanced knowledge of them) then
the information contained in this Quick Start Guide should be enough to get you up
and running. Eventually you should try to look through all the documentation (more
detailed descriptions of the functions, setup and system controls are covered in the
remainder of the User’s Manual), but do not worry if you do not understand every-
thing the first time. Keep this manual nearby and refer to it to learn as you go. You
may find it useful to refer to the notes marked with a  as indicated in the margin.
For a more detailed description of any of the interface ports and jacks see “Interface
(Ports & Jacks)” on page  A - 1.

Warning Boxes
No matter what your level please pay careful attention to the warning and safety information indicated by the
 symbol. Also please note the safety and handling instructions as indicated in the Preface.


Notes

Check the light colored
boxes with the mark
above to find detailed
information about the
computer’s features. 
1 - 2 Overview
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Not Included
Operating Systems (e.g. Windows 8) and applications (e.g. word processing, spreadsheet and database programs)
have their own manuals, so please consult the appropriate manuals.


Drivers

If you are installing new system software, or are re-configuring your computer for a different system, you will need to install
the drivers listed in “Drivers & Utilities” on page 4 - 1. Drivers are programs which act as an interface between the com-
puter and a hardware component e.g. a wireless network module. It is very important that you install the drivers in the order
listed in Table 4 - 1, on page 4 - 4. You will be unable to use most advanced controls until the necessary drivers and util-
ities are properly installed. If your system hasn’t been properly configured (your service representative may have already
done that for you), refer to “What to Install” on page 4 - 1 for installation instructions.

Ports and Jacks

See “Computer Ports and Jacks” on page A - 2 for a description of the interface (ports & jacks) which allow your com-
puter to communicate with external devices, connect to the internet etc.
Overview 1 - 3
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System Software
Your computer may already come with system software pre-installed. Where this is not the case, or where you
are re-configuring your computer for a different system, you will find the Windows 7 (with Service Pack 1 in-
stalled) and Windows 8 operating systems are supported. 

The majority of this menu covers information covers information related to the Windows 8 operating system,
however for specific information on the Windows 7 operating system see Appendix D.

Note: In order to run Windows without limitations or decreased performance, your computer requires a mini-
mum 1GB of system memory (RAM).


Windows 7/8 OS

In order to run Windows 7 or 8 (32 Bit) without limitations or decreased performance, your computer requires a minimum
1GB of system memory (RAM), however if you are running Windows 7 or 8 (64 bit) your computer requires a minimum
2GB of system memory (RAM).
1 - 4 Overview



Quick Start Guide 1
System Startup
1. Remove all packing materials, CDs/DVDs and floppy disks etc.
2. Securely attach any peripherals you want to use with the computer to their ports (e.g keyboard and mouse etc.)
3. Attach the AC/DC adapter to the DC-In jack located under the LCD, then plug the AC power cord into an outlet, 

and connect the AC power cord to the AC/DC adapter.
4. Push the power button at the front of the computer (under the LCD) to turn the computer “on”.

Figure 1 - 1 - AC/DC Adapter Plugged-In/Power Button


Shutdown

Note that you should always shut your computer
down by choosing the Shut Down command
from the bottom right of the Start menu in Win-
dows 7, or by choosing the Shut Down com-
mand from the Power item in Settings in the
Charms Bar (use the Windows Logo Key   + C
key combination to access the Charms Bar) in
Windows 8. This will help prevent hard disk or
system problems.

Power Button (located along the bottom of the LCD)
System Startup 1 - 5
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System Map: Front View

Figure 1 - 2 - Front View

5

1

4

1. Built-In PC Camera
2. PC Camera LED
3. Built-In Microphone
4. LCD (With Optional Touch Panel for 

Windows 7 OS)
5. Power & System Activity LED Indicators
6. Function Buttons*
7. Power Button*
8. RJ-45 LAN Jack
9. 2 * USB Ports
10. eSATA Port
11. External Monitor Port
12. 2 * COM Ports
13. DC-In Jack

6 7
5

*Note the power and function buttons are located 
along the bottom underside of the LCD
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Tilting & Adjusting the LCD Screen Height
It is possible to tilt the LCD screen in order to get the best possible viewing angle of the screen without glare etc,
and to raise/lower the screen height in order to get the best possible vertical viewing position of the screen. 

• Hold the left and right sides of the computer to raise/lower the screen.
• Do not hold the bottom of the screen to adjust the viewing angle or height as the screen function buttons 

are located there.

Figure 1 - 3 - LCD Screen Raise/Lower
Tilting & Adjusting the LCD Screen Height 1 - 7
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• Carefully apply pressure at the top of the screen to tilt it.
• Note that the screen has no fixed lock position and you are free to raise/lower and tilt the screen to any 

position the stand allows (do not force it beyond the point of resistance).

Figure 1 - 4 - LCD Screen Tilt


Moving the Computer

We strongly recommend using
both hands to move the computer.
You can use one hand to grip the
computer by the stand, and the
other to hold the top of the LCD
screen. 

It is recommended that you carry
the computer with the LCD facing
your body to avoid scratching the
surface against other objects.
However take care not to scratch
the LCD with any personal items,
belt fittings or jewelry etc.(one
hand gripping the stand and the
other gripping the top of the com-
puter to avoid accidentally drop-
ping it).
1 - 8 Tilting & Adjusting the LCD Screen Height
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LED Indicators & Buttons
The LED indicators on the computer display helpful
information about the current status of the computer.

Table 1 - 1 - LED Indicators

The buttons located under the front panel icons allow
you to make screen and input adjustments.

Figure 1 - 5 - Front Icons

Table 1 - 2 - Function Buttons

Icon Color Description

Green The computer is On

Blinking Green The computer is in Sleep Mode

Orange
The AC/DC Adapter is Plugged in 
& the Computer is Powered Off

Green System Activity

Icon Description

Decrease/Increase Buttons - Use the buttons 
to decrease/increase the brightness/volume

Function Menu Toggle - Use this button to 
display the On Screen Display (see “On 

Screen Display Indicators” on page 1 - 10)

Screen Power Toggle - Use this button to 
toggle the LCD on/off
LED Indicators & Buttons 1 - 9
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On Screen Display Indicators
Press the function menu button  (see Table 1 - 2, on page 1 - 9) to bring up the On Screen Display. The OSD
provides visual indicators for brightness, volume, WLAN, Bluetooth and camera power toggle (note that the
camera and Bluetooth power indicators will only display if the modules are included in your purchase configu-
ration) are available when the OSD driver is installed (see “On Screen Display” on page 4 - 6).

Table 1 - 3 - On Screen Display Indicators

The indicators will appear when the computer boots up, or resumes from a power saving state, in order to display
the current power status of the camera and/or Bluetooth/WLAN modules. The OSD indicators will appear if you
adjust the brightness or volume, and will also allow you to adjust the power status of the camera and/or Blue-
tooth/WLAN modules by using the mouse to click on the icon (note that this system does not display the Win-
dows Mobility Center). If your purchase configuration includes the Multi-Touch Panel (Windows 7 only) you
may use a finger to slide along the bars under the on-screen symbols to adjust the volume and brightness and
controls, or to press the on/off buttons to toggle power to the camera and/or Bluetooth/WLAN modules.

OSD Icon Description OSD Icon Description

Volume Decrease/Increase WLAN Power Toggle

Brightness Decrease/Increase Bluetooth Power Toggle

Camera Power Toggle
1 - 10 On Screen Display Indicators



Quick Start Guide 1
System Map: Left View
Figure 1 - 6
Left View

1. Stand
2. Multi-in-1 Card 

Reader 
3. ExpressCard Slot 

(see page 2 - 7)
4. 3 * USB 3.0 Ports
5. Headphone/

Speaker-Out 
Jack

6. Microphone-In 
Jack



ExpressCard Slot

The ExpressCard Slot
accepts either Express-
Card/34 or Express-
Card/54 formats.

3

4

4

4

2

5

6

1



Multi-in-1 Card Reader

The card reader allows you to use the most 
popular digital storage card formats:

MMC (MultiMedia Card) / RSMMC
SD (Secure Digital) / Mini SD / SDHC / 

SDXC Compatible
MS (Memory Stick) / MS Pro / MS Duo

USB 3.0 Port

USB 3.0 ports are denoted by their blue col-
or; USB 2.0 ports are colored black. Note
that the USB 3.0 ports require a driver for
Windows 7 (see ““USB 3.0 (Win 7 Only)”
on page D - 24) installation (Windows 8
does not require a driver installation) and
do not support wake on USB.
System Map: Left View 1 - 11
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System Map: Right View
Figure 1 - 7 - Right View

1. Stand
2. Optical Device Drive Bay 

(for CD/DVD Device - see 
page 2 - 3)

3. Security Lock Slot

2

3

1


CD/DVD Emergency Eject

If you need to manually eject a CD/
DVD (e.g. due to an unexpected
power interruption) you may push
the end of a straightened paper
clip into the emergency eject hole.
Do not use a sharpened pencil or
similar object that may break and
become lodged in the hole.


Changing DVD Regional Codes

Go to the Control Panel and double-click
Device Manager (Hardware and Sound),
then click the + next to DVD/CD-ROM
drives. Double-click on the DVD-ROM de-
vice to bring up the Properties dialog box,
and select the DVD Region (tab) to bring up
the control panel to allow you to adjust the
regional code. You can select your module’s
region code 5 times (see “DVD Region
Note” on page 2 - 5).


Media Warning

Don’t try to remove the CD/DVD while the
system is accessing it. This may cause the
system to “crash”.
1 - 12 System Map: Right View
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System Map: Rear View
Figure 1 - 8
Rear View

1. Stand
2. Rear Component 

Cover
3. Vent/Fan Intake
4. Security Lock Slot
5. Carrying Handle 

Area1

3

2

3 3


CPU

The CPU is not a user serviceable
part. Opening this compartment, or
accessing the CPU in any way,
may violate your warranty.

Overheating

To prevent your computer from
overheating make sure nothing
blocks the Vent/Fan Intake while
the computer is in use.

4

5


Carrying the Computer

We strongly recommend using both hands to move the computer (one hand gripping the
handle area and the other gripping the computer) to avoid accidentally dropping it. Be
careful that objects such as belt buckles etc. do not scratch the screen while it is being
carried.
System Map: Rear View 1 - 13
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Windows Control Panel
Most of the control panels, utilities and applications within Windows are accessed from the Start menu in Win-
dows 7 (Windows 7’s standard interface is the desktop), and from the Desktop in Windows 8 (see page 1 - 21
for more information on the Windows 8 Control Panel).

Throughout this manual you will see an instruction to open the Control Panel. In Windows 8 right-click the
lower left hot corner to bring up the context menu (or use the Windows Logo Key  + X key combination)
and select Control Panel. If you are using a Touch Screen then access the Charms Bar from the desktop
(not the Start screen), tap Settings, and tap Control Panel or access it from the All Apps menu.

Figure 1 - 9 - Windows 8 Context Menu & Charms Bar Settings (from Desktop App)

Move the mouse to the

and right-click to access 
bottom left of the screen 

the menu.
1 - 14 Windows Control Panel
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Windows 8 Start Screen & Desktop
The apps, control panels, utilities and programs within Windows 8 are accessed from the Metro user interface’s
Start screen and/or Windows Desktop. The Desktop (which runs as an app within the Start screen) can be ac-
cessed by clicking/tapping the Desktop item in the Start screen (or by using the Windows Logo Key  + D
key combination).

Figure 1 - 10 - Windows Start Screen

Desktop App
Windows 8 Start Screen & Desktop 1 - 15
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Apps & Tiles
The Windows 8 Start screen will contain a number of apps, and many more will be installed as you add more
applications etc. Not all of these apps can fit on one screen so you will often need use the slider at the bottom of
the screen in order to view all the necessary Apps.

Accessing Pining/Unpinning All Apps
You can add and remove the tiles for apps and control panels in the Start screen. Right-click on a blank area
of the Metro UI Start screen and you will see the All Apps icon. Click the All Apps icon to display all the
installed applications etc. Right-click any icon, to bring up the menu at the bottom of the screen. You can then
click the appropriate icon to pin the App to (or unpin from) the Start screen, or to the taskbar in the Desktop
application.

Figure 1 - 11 - All Apps

 
Right-click an icon to display the menu

Start Screen and click All Apps
 

Right-click on a blank area of the 
1 - 16 Windows 8 Start Screen & Desktop
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Desktop Application
When the Desktop app is running (click the app in the Start screen or use the Windows Logo Key  + D key
combination), and you are using a keyboard, you can use lower left hot corner to switch between the Start screen
and the Windows Desktop. To do so move your mouse to hover over the bottom left corner of the screen and
click the pop-up.

When you move to the lower left hot corner in the Start screen itself it will take you back to your most recently
used app. 

Figure 1 - 12 - Desktop

Move the mouse to the bottom left of the screen and click to switch
back to the Start screen.
Windows 8 Start Screen & Desktop 1 - 17
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When the Desktop app is running you can right-click (keyboard only) the lower left
hot corner (or use the Windows Logo Key  + X key combination) to bring up an
advanced context menu of useful features such as Control Panel, Programs and Fea-
tures, Power Options, Task Manager, Search, Windows Explorer, Command Prompt,
Device Manager and Network Connections etc.

Figure 1 - 13 - Advanced Context Menu (Right-Click lower left hot corner)


Display Most 

Recently Used 
Apps

If you are in the Start
screen, Desktop or an
app you can move your
mouse to the upper left
corner of the screen to
get back to the most re-
cently used app. 

To view all the most re-
cently used Apps hover
over the top left of the
screen and then move
the mouse down along
the left side of the
screen to display the
list.

Move the mouse to the bottom left of the screen 

and right-click to access the menu.
1 - 18 Windows 8 Start Screen & Desktop
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Windows 8 Charms Bar
The right side of the screen displays the Windows 8 Charms Bar. The Charms Bar contains the Search, Share,
Start, Devices and Settings menus. To access up the Charms Bar move the cursor to the upper or lower right
corners of the screen, and then hover over one of the items in the Charms Bar to activate it (the bar will be black
when it is active), or use the Windows Logo Key  + C key combination. 

Figure 1 - 14 - Start Screen with Charms Bar

 

Move the mouse over a Charms Bar icon to activate the menu 

Move the mouse to the top/lower right icons to activate the Charms Bar 

Move the mouse to the top/lower right icons to activate the Charms Bar 
Windows 8 Start Screen & Desktop 1 - 19
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Charms Bar Items

• Search : You can search for any file, application, Apps and control panel settings with instantaneous 
results.

• Share : This button is used to share information with people via mail or social networks.

• Start : Click to bring up the Start Menu (the same function as pressing the Windows Logo Key or click-
ing the bottom left of the screen). 

• Devices : Click this button to change connected peripheral device settings e.g. an external display.

• Settings : This button gives instant access to the computer settings, such as Network, Audio, Notifica-
tions, Power and Keyboard (click Change PC Settings to activate the PC Settings menu).

Figure 1 - 15 - Settings Menu
1 - 20 Windows 8 Start Screen & Desktop
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Windows 8 Control Panel
In many instances throughout this manual you will see an instruction to open the Control Panel. The Control
Panel is much the same as that in Windows 7, however it can be accessed in a number of ways in Windows 8.

• Click Search in the Windows Charms Bar (see previous page) and the search pane will pop out. Type 
Control Panel and select it from the results to the left.

Figure 1 - 16 - Search (Control Panel)

• Click on Computer (you may need to pin Computer to the Start screen) in the Start screen, click on 
Computer in the top menu and select Open Control Panel from the ribbon.

Figure 1 - 17 - Open Control Panel (Computer)
Windows 8 Control Panel 1 - 21
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• When in the Desktop app (this does not apply to the Start screen) click on Settings in the Windows 

Charms Bar and select Control Panel from the menu.

Figure 1 - 18 - Settings Charms Bar (Desktop App Only)

• Right-click on a blank area of the Metro UI Start screen, click the All Apps icon and click Control 
Panel.

Figure 1 - 19 - All Apps - Control Panel
1 - 22 Windows 8 Control Panel
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• Right-click the lower left hot corner to bring up the menu and select Control Panel (see Figure 1 - 13 on 

page 1 - 18).


Keyboard Shortcut to Control Panel

You can also use keyboard shortcuts to access the Control Panel. Press the Windows logo key  and X to bring up
the context menu, and then press P to bring up the Control Panel. Alternatively press the Windows logo key  and R
to bring up the Run dialog box, and then type “Control Panel” and press Enter to access the Control Panel.
Windows 8 Control Panel 1 - 23
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Windows 8 Taskbar
In many instances throughout this manual you will see an instruction to access the notification area of the task-
bar. In Windows 8 the taskbar is accessed from the Desktop application. If you are in the Start screen you will
need to click the Desktop app to switch to the Desktop.

The taskbar is displayed in much the same way as it was in Windows 7, and you can see the notification area of
the taskbar in the bottom right of the screen. Some of the Control Panels and applications referred to during the
course of this manual can be accessed from here.

Figure 1 - 20 - Desktop Taskbar

You can pin/unpin apps to/from the taskbar in much the same way as you can to the Start screen (see “Accessing
Pining/Unpinning All Apps” on page 1 - 16).
1 - 24 Windows 8 Control Panel
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Keyboard Shortcuts - Windows 8
If you are using a keyboard with this system then note the function of the Windows
Logo Key & Menu/Application Key (in the Start screen). The following keyboard
shortcuts are useful for navigation/operation in Windows 8.

Windows Logo  Key + Description

Tap Winkey
Toggle between the Start screen and the foremost 

running app or the Windows Desktop

C Display Charms menu

D Switch to the Windows Desktop and toggle show Desktop 

E
 Switch to the Windows desktop and launch Windows 

Explorer with Computer displayed

F Display file Search

I Open the Settings charm

K Open the Connect charm

L Lock the computer and display the Lock screen

P  Display the Second Screen menu

R
Switch to the Windows Desktop and display the Run 

dialog box

Z Access the App Bar


Windows Logo 

Keyboard Shortcut

Use the Windows logo
key  + D key combi-
nation to switch be-
tween the Start screen
and Windows Desktop.

Menu/Application 
Keyboard Shortcut

When the Desktop app
is running you can use
the Menu/Application
key  on the keyboard
to display the context
menu as per a mouse
right-click. In the Start
screen this function is
useful to quickly display
the All Apps icon.

Table 1 - 4

Windows 8 

Keyboard Shortcuts
Keyboard Shortcuts - Windows 8 1 - 25



Quick Start Guide1
Video Features
You can switch display devices, and configure display options, from the Display control panel (in Appearances
and Personalization) in Windows 8 in the same manner as Windows 7 running the Desktop app (see “Desktop
Application” on page 1 - 17 and Appendix B). In Windows 8 it is possible to quickly configure external displays
from the Devices menu item in the Charms Bar (see “Windows 8 Charms Bar” on page 1 - 19).

To Configure Displays from Devices (Charms Bar):
1. Attach your display to the external monitor port, and turn it on.
2. Go the Charms Bar and select Devices.
3. Click Second Screen.
4. Click on any one of the options from the menu to select Duplicate, Extend or a Single display.

Figure 1 - 21 - Second Screen (Devices)
1 - 26 Video Features
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To access Display (Control Panel) and Screen Resolution in Windows 8:
1. Go to the Control Panel.
2. Click Display (icon) - In the Appearance and Personalization category.
3. Adjust resolution.

Figure 1 - 22 - Screen Resolution

1

3

2


Right-Click Desktop App

1. You can right-click the 
desktop and select 
Screen resolution  
(Figure 1 - 22).

2. Use the dropbox to 
select the screen 
Resolution  (Figure 1 
- 22).

3. Click Advanced 
settings  (Figure 1 - 
22) to bring up the 
Advanced properties 
tabs.

1

2

3
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To access the Intel(R) Graphics Media Accelerator Driver for mobile control panel:
1. Click Advanced settings  (Figure 1 - 22 on page 1 - 27) in the Screen Resolution control panel in Win-

dows.
2. Click the Intel(R)... tab and click Graphics Properties (button)  (Figure 1 - 23 on page 1 - 28).
OR
3. Right-click the desktop and select Graphics Properties from the menu.
OR
4. Click the icon  in the notification area of the Desktop taskbar and select Graphics Properties from the menu.

Figure 1 - 23 - Intel GMA Driver for Mobile Control Panel

3

4

4
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Power Options
Power Options (Hardware and Sound) can be accessed from the Control Panel. The Power Menu item in Set-
tings in the Charms Bar in Windows 8 may be used to Shut down or Restart (you can also add Hibernate/
Sleep to the menu - see “Adding Hibernate/Sleep to the Power Menu” on page 3 - 9).

Shut Down, Restart or Sleep
1. Go to the Charms Bar and click Settings.
2. Click Power .
3. Select Sleep, Shut Down or Restart.

Figure 1 - 24 - Power (Settings)
Power Options 1 - 29
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Running Metro UI Apps
To run apps in the Metro UI in Windows 8 you will need to check that the Screen Resolution and User Account
Control Settings are compatible with the system requirements.

Screen Resolution Settings
1. Switch to the Windows Desktop (click the app or use the Windows logo key  + D key combination).
2. Right-click a blank area of the Windows Desktop and select Screen Resolution. Adjust the Resolution to 

make sure that it is at least 1024 * 768, although preferably 1366 * 768 or above (see sidebar).

Figure 1 - 25 - Screen Resolution


Screen Resolution for Metro Style Apps 

(Windows 8)

The minimum resolution in which Metro style Apps will run is 1024x768. 

The minimum resolution required to support all the features of Windows
8 (including multitasking with snap) is 1366x768. 

These specs are the minimum screen resolution that supports all the
features of Windows 8 on a useful physical size. 
1 - 30 Running Metro UI Apps
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User Account Control Settings
If your computer meets the minimum screen resolution requirements, and still you can't run Metro apps, then
that you have to check the status of User Account Control (UAC). Metro apps may fail to open when the UAC
is turned off. To check whether the UAC is on or off, follow the instructions below.

1. Open the Control Panel.
2. Click on User Accounts and then click on Change User Account Control settings (or click System and 

Security and click Change User Account Control Settings under Action Center).
3. If the slider is in the Never notify position, then the UAC is disabled. 
4. To enable or turn on the UAC, move the slider to Always notify or Notify me when apps try to make changes 

to my computer (default) position, and then click OK. 

Figure 1 - 26 - User Account Control
Running Metro UI Apps 1 - 31
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Chapter 2: Features & Components

Overview
Read this chapter to learn more about the following main features and components
of the computer:

• Hard Disk Drive
• Optical (CD/DVD) Device
• Multi-in-1 Card Reader
• ExpressCard Slot
• Audio Features
Overview 2 - 1
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 Hard Disk Drive
The hard disk drive is used to store your data in the computer. The hard disk can be
taken out to accommodate two other 2.5"serial (SATA) hard disk drives with a
height of 9.5 mm.

The hard disk is accessible from the rear of your computer as seen below. For further
details see “Upgrading the Hard Disk Drive” on page 6 - 6.


Power Safety

Before attempting to ac-
cess any of the internal
components of your
computer please ensure
that the machine is not
connected to the AC
power, and that the ma-
chine is turned off. Also
ensure that all peripher-
al cables, including
phone lines, are discon-
nected from the comput-
er.

Figure 2 - 1
Hard Disk Location Hard Disk
2 - 2 Hard Disk Drive
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Optical (CD/DVD) Device
There is a bay for a 5.25" optical (CD/DVD) device (12.7mm height). The actual de-
vice will depend on the module you purchased (see “Storage” on page C - 3). The
optical device is usually labeled “Drive D:” and may be used as a boot device if
properly set in the BIOS (see “Boot Menu” on page 5 - 12).

Loading Discs
To insert a CD/DVD, press the open button  and
carefully place a CD/DVD onto the disc tray with la-
bel-side facing up (use just enough force for the disc
to click onto the tray’s spindle). Gently push the CD/
DVD tray in until its lock “clicks” and you are ready
to start. The busy indicator  will light up while
data is being accessed, or while an audio/video CD,
or DVD, is playing. If power is unexpectedly inter-
rupted, insert an object such as a straightened paper
clip into the emergency eject hole  to open the
tray.


Volume Adjustment

The sound volume level
can be set using the vol-
ume control in the Set-
tings menu in the
Charms Bar (see “Au-
dio Features” on
page 2 - 8).

 Figure 2 - 2
Optical Device

1

2

3

1

2

3
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Handling CDs or DVDs
Proper handling of your CDs/DVDs will prevent them from being damaged. Please
follow the advice below to make sure that the data stored on your CDs/DVDs can be
accessed.

Note the following:

• Hold the CD or DVD by the edges; do not touch the surface of the disc.
• Use a clean, soft, dry cloth to remove dust or fingerprints.
• Do not write on the surface with a pen.
• Do not attach paper or other materials to the surface of the disc.
• Do not store or place the CD or DVD in high-temperature areas.
• Do not use benzene, thinner, or other cleaners to clean the CD or DVD.
• Do not bend the CD or DVD.
• Do not drop or subject the CD or DVD to shock.


CD Emergency Eject

If you need to manually
eject a CD (e.g. due to
an unexpected power
interruption) you may
push the end of a
straightened paper clip
into the emergency eject
hole. However please
do NOT use a sharp-
ened pencil or similar
object that may break
and become lodged in
the hole.

Disk Eject Warning

Don’t try to remove a
CD/DVD while the sys-
tem is accessing it. This
may cause the system
to “crash”.
2 - 4 Optical (CD/DVD) Device
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DVD Regional Codes
To change the DVD regional codes:

1. Go to the Control Panel 
2. Double-click Device Manager (Hardware and Sound), then click the + next to 

DVD/CD-ROM drives. 
3. Double-click on the DVD-ROM device to bring up the Properties dialog box, and 

select the DVD Region (tab) to bring up the control panel to allow you to adjust the 
regional code.


DVD Region Note

DVD region detection is
device dependent, not
OS-dependent. You can
select your module’s re-
gion code 5 times. The
fifth selection is perma-
nent. This cannot be al-
tered even if you change
your operating system
or you use the module in
another computer.

 Figure 2 - 3
DVD Region Codes

• Region 1 - USA & Canada

• Region 2 - Western Europe, Japan, 
South Africa, Middle East & Egypt

• Region 3 - South-East Asia, Taiwan, 
South Korea, The Philippines, Indo-
nesia, Hong Kong

• Region 4 - South & Central Amer-
ica, Mexico, Australia, New Zealand

• Region 5 - N Korea, Russia, Eastern 
Europe, India & Most of Africa

• Region 6 - China
Optical (CD/DVD) Device 2 - 5
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 Multi-in-1 Card Reader
The card reader allows you to use some of the latest digital storage cards. Push the
card into the slot and it will appear as a removable device, and can be accessed in
the same way as your hard disk (s). Make sure you install the Card Reader driver
(see “ExpressCard/Card Reader” on page 4 - 7).


Card Reader Cover

Make sure you keep the
cover in the card reader
when not in use. This
will help prevent foreign
objects and/or dust get-
ting in to the card read-
er.

 Figure 2 - 4
Left View

1. Card Reader

• MMC (MultiMedia Card) / RSMMC
• SD (Secure Digital) / Mini SD / SDHC / SDXC 
• MS (Memory Stick) / MS Pro / MS Duo

1
1
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ExpressCard Slot
The computer is equipped with an ExpressCard/34/54 slot that reads Express Card/
34 and ExpressCard/54 formats. ExpressCards are the successors to PCMCIA (PC
Cards).

ExpressCard/54 is used for applications
which require a larger interface slot, e.g.
CompactFlash card reader. The number de-
notes the card width; 54mm for the Express
Card/54 and 34mm for the ExpressCard/34.
Make sure you install the Card Reader driv-
er (see “ExpressCard/Card Reader” on
page 4 - 7).

Inserting and Removing 
ExpressCards
• Align the ExpressCard with the slot and 

push it in until it locks into place.
• To remove an ExpressCard, simply 

press the card to eject it.


ExpressCard Slot 

Cover

Make sure you keep the
cover in the Express-
Card slot when not in
use. This will help pre-
vent foreign objects and/
or dust getting in to the
ExpressCard Slot.

 Figure 2 - 5
Left View

1. ExpressCard 
Slot

1

1

ExpressCard Slot 2 - 7
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 Audio Features
You can configure the audio options on your computer from the Sound  control
panel in Windows, or from the Realtek HD Audio Manager  icon in the taskbar
notification area/control panel of the Desktop app (right-click the taskbar notifica-
tion area icon  to bring up an audio menu). The volume may also be adjusted by
means of the volume icon in the taskbar or the audio slider in the Settings menu
(see sidebar). 


Volume Adjustment

The sound volume level
can be set using the vol-
ume control in the Set-
tings menu in the
Charms Bar.

 Figure 2 - 6
Realtek Audio 

Manager

Right-click the icon 
to access the menu 
above.

Note that many keyboards have built-in controls to allow you to adjust the audio volume.
2 - 8 Audio Features
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Setup for Audio Recording
To record audio sources on your computer at optimum quality follow the instruc-
tions below:

1. Go to the Control Panel.
2. Click Realtek HD Audio Manager (Hardware and Sound), or right-click the 

taskbar icon  and select Sound Manager.
3. Click Microphone Effects (tab) in Microphone (tab), and then click to select 

Noise Suppression (button), or adjust the Recording Volume level to around 60, 
to obtain the optimum recording quality.

4. Click OK to close the control panel and save the settings.

 Figure 2 - 7
Realtek Audio 

Manager - 
Recording Setup
Audio Features 2 - 9
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Chapter 3: Power Management

Overview
To conserve power, especially when using the battery, your computer power man-
agement conserves power by controlling individual components of the computer
(the monitor and hard disk drive) or the whole system.

This chapter covers:

• AC/DC Adapter
• Turning On the Computer
• Power Plans
• Power-Saving States
• Configuring the Power Buttons

The computer uses enhanced power saving techniques to give the operating system
(OS) direct control over the power and thermal states of devices and processors. For
example, this enables the OS to set devices into low-power states based on user set-
tings and information from applications.

Using some form of power management greatly increases the life span of the
LCD.


OS Note

Power management
functions will vary slight-
ly depending on your
operating system. For
more information it is
best to refer to the user’s
manual of your operat-
ing system. 

(Note: All pictures used
on the following pages
are from the Windows 8
OS.)

Power Options

Power management in
Windows is configured
from Power Options
(Hardware and
Sound), which can be
accessed from the Con-
trol Panel (see page 1 -
21).
Overview 3 - 1
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AC/DC Adapter
Use only the AC/DC adapter that comes with your computer. The wrong type of AC/
DC adapter will damage the computer and its components.

1. Attach the AC/DC adapter to the DC-In jack located under the LCD.
2. Plug the AC power cord into an outlet, and then connect the AC power cord to the 

AC/DC adapter.
3. Adjust the LCD to a comfortable viewing angle.
4. Press the power button on the front of the computer for about 2 - 3 seconds to 

turn the computer “on” (note that the power LED on the front of the computer will 
turn from orange to green when the computer powers on).
3 - 2 AC/DC Adapter
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Turning On the Computer
Now you are ready to begin using your computer. To turn it on simply press the pow-
er button on the front panel.

When the computer is on, you can use the power button as a Stand by/Hibernate/
Shutdown hot-key button when it is pressed for less than 4 seconds (pressing and
holding the power button for longer than this will shut the computer down). Use
Power Options (Hardware and Sound) in the Windows control panel to configure
this feature.

Figure 3 - 1
Power Menu 

(Settings - Charms 
Bar)


Shut Down

Note that you should always shut your com-
puter down by choosing the Shut Down
command from the Power Menu in the Set-
tings menu in the Windows 8 Charms Bar. 

This will help prevent hard disk or system
problems. If you want to add Hibernate/
Sleep to the Power Menu see “Adding Hi-
bernate/Sleep to the Power Menu” on
page 3 - 9.
Turning On the Computer 3 - 3
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Power Plans
The computer can be configured to conserve power by means of power plans. You
can use (or modify) an existing power plan, or create a new one.

The settings may be adjusted to set the display to turn off after a specified time, and
to send the computer into Sleep after a period of inactivity. 

Click Change plan settings and then click Change advanced power settings to ac-
cess further configuration options in Advanced Settings.


Resuming 
Operation

See Table 3 - 1, on
page 3 - 10 for informa-
tion on how to resume
from a power-saving
state.

Password

It is recommended that
you enable a password
on system resume in or-
der to protect your data.

Figure 3 - 2
Power Plan 

Advanced Settings
3 - 4 Power Plans
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Each Windows power plan will also adjust the processor performance of your ma-
chine in order to save power. This is worth bearing in mind if you are experiencing
any reduced performance.

Choose High performance (you may need to click Show additional plans to view
the High performance plan) for maximum performance. Choose the Power saver
(bear in mind that this scheme may slow down the overall performance of the com-
puter in order to save power) for maximum power saving when required.

Figure 3 - 3
Power Plans

Click to 

 

Show/Hide
Additional
Plans 
Power Plans 3 - 5
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Power-Saving States
You can use power-saving states to stop the computer’s operation and restart where
you left off. Win 8 uses the Sleep, Hibernate and Shut Down power-saving states.

Sleep
In Sleep all of your work, settings and preferences are saved to memory before the
system sleeps. When you are not using your computer for a certain length of time,
which you specify in the operating system, it will enter Sleep to save power. 

The PC wakes from Sleep within seconds and will return you to where you last left
off (what was on your desktop) without reopening the application(s) and file(s) you
last used.

To add Sleep to the Power Menu see “Adding Hibernate/Sleep to the Power
Menu” on page 3 - 9.


Wake On LAN 

Support 
(Windows 8)

Wake-On-LAN is only
supported from Sleep or
Hibernate states in
Windows 8.

If you require your com-
puter to wake up from
network activity in Win-
dows 8 then make sure
that the computer is ei-
ther in Sleep or Hiber-
nate.

Wake-On-LAN is not
supported from Shut-
down states in Win-
dows 8.
3 - 6 Power-Saving States
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Hibernate
Hibernate uses the least amount of power of all the power-saving states and saves
all of your information on a part of the hard disk before it turns the system off. If a
power failure occurs the system can restore your work from the hard disk; if a power
failure occurs when work is saved only to memory, then the work will be lost. Hi-
bernate will also return you to where you last left off within seconds. You should
put your PC into Hibernate if you will not use the computer for a period of time. To
add Hibernate to the Power Menu see “Adding Hibernate/Sleep to the Power
Menu” on page 3 - 9.

Shut down
You should Shut down the computer if you plan to install new hardware, plan to be
away from the computer for several days, or you do not need it to wake up and run
a scheduled task. Returning to full operation from Shut down takes longer than from
Sleep or Hibernate.

Figure 3 - 4
Power Menu
Power-Saving States 3 - 7
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Configuring the Power Buttons
The power button may be set to send the computer in to either Sleep or Hibernate.
In Sleep, the LED  will blink green. In Hibernate the LED will be orange. If only
the display is turned off, the LED will remain green. Click Choose what the power
buttons do on the left menu in Power Options to bring up the menu.


Password 
Protection

It is recommended that
you enable a password
on wake up in order to
protect your data.

However you can dis-
able this setting from the
Power Options menu
by clicking Require a
password on wakeup
in the left menu, and se-
lecting the options (click/
tap Change settings
that are currently un-
available).

Figure 3 - 5
Power Options 
Define Power 

Buttons
3 - 8 Configuring the Power Buttons
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Adding Hibernate/Sleep to the Power Menu
Add Hibernate/Sleep to the Power Menu as follows.

1. Go to the Power Options (Hardware and Sound) control panel (see page 1 - 29).
2. Click “Change settings that are currently unavailable” .
3. Click Choose what the power buttons do.
4. Click to put a tick in the Hibernate/Sleep box under Shutdown settings.
5. Click Save Changes and close the control panel.

Figure 3 - 6
Power Options 
Define Power 

Buttons - Shutdown 
Settings
Configuring the Power Buttons 3 - 9
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Resuming Operation
You can resume operation from power-saving states by pressing the power button,
or in some cases pressing the sleep button (see your keyboard documentation).

Power Status Icon  Color To Resume

Power Off Off Press the Power Button

Sleep Blinking Green

Press the Power Button

Press the Sleep Button 
(see your keyboard documentation)

Hibernate Orange (AC/DC adapter) Press the Power Button

Display Turned Off Green Press the  Screen Power Toggle Button

Table 3 - 1
Resuming 

Operation


Power Button

When the computer is on, you can use the power button as a Sleep/Hibernate/Shut Down
hot key button when it is pressed for less than 4 seconds (pressing and holding the power
button for longer than this will force the computer to shut down).
3 - 10 Configuring the Power Buttons



Power Management

3

Ctrl + Alt + Delete Key Combination
You can use the CTRL + ALT + DEL key combination from almost any of the Win-
dows 8 interfaces/apps to bring up a full-screen displaying Lock, Switch User, Log
off, Change a password and Task Manager options. If you click the Power icon
in the lower right corner of the screen a power management option menu appears to
display Sleep, Shut down, and Restart.

To fully control all the power options (including Hibernate mode) go to the Power
Options control panel and configure the power button and sleep button to perform
the function selected.

Figure 3 - 7
Ctrl + Alt + Delete 

Menu
Configuring the Power Buttons 3 - 11
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Chapter 4: Drivers & Utilities
This chapter deals with installing the drivers and utilities essential to the operation or
improvement of some of the computer’s subsystems. The system takes advantage of
some newer hardware components for which the latest versions of most available op-
erating systems haven’t built in drivers and utilities. Thus, some of the system com-
ponents won’t be auto-configured with an appropriate driver or utility during
operating system installation. Instead, you need to manually install some system-re-
quired drivers and utilities.

For information on the Windows 7 operating system see Appendix D.

What to Install
The Device Drivers & Utilities + User’s Manual disc contains the drivers and util-
ities necessary for the proper operation of the computer. Table 4 - 1, on page 4 - 4
lists what you need to install and it is very important that the drivers are installed
in the order indicated (all drivers provided are for Windows 8 & Windows 7 with
Service Pack 1).

The procedures for installing drivers for the PC Camera, Wireless LAN and Blue-
tooth & WLAN Combo modules are provided in “Modules & Options” on page 7
- 1.


Driver Installation & 

Power

When installing driv-
ers make sure your
computer is powered
by the AC/DC adapter
connected to a work-
ing power source.
Some drivers draw a
significant amount of
power during the instal-
lation procedure, and if
the remaining battery
capacity is not adequate
this may cause the sys-
tem to shut down and
cause system problems
(note that there is no
safety issue involved
here, and the battery will
be rechargeable within 1
minute).
What to Install 4 - 1
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Driver Installation (Windows 8)
1. Insert the Device Drivers & Utilities + User’s Manual disc into the computer’s DVD drive.
2. Click the message “Tap to choose what happens with this disc.”
3. Click Run autorun.exe.

Figure 4 - 1 - Autorun Driver Installation Disc

4. Click Install Drivers (button), or Option Drivers (button) to access the Optional driver menu.
5. Check the driver installation order from Table 4 - 1, on page 4 - 4 (the drivers must be installed in this order) 

which is the same as that listed in the Drivers Installer menu below.
6. Click to select the driver you wish to install, (you should note down the drivers as you install them).
7. Follow the instructions for each individual driver installation procedure as listed on the appropriate pages.


Driver Installation

If you miss the message above you can eject the De-
vice Drivers & Utilities + User’s Manual disc and then
reinsert it.

Alternatively double-click the disc icon in Comput-
er (use the Windows logo key  + E key combina-
tion to go to Computer in Windows Explorer).
4 - 2 What to Install
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Follow the instructions to install the driver. Alternatively click Start, navigate (Browse..) to the executable file
and then follow the manual setup instructions. Note: If you need to reinstall any driver, you should uninstall the
driver first.

Figure 4 - 2 - Drivers Installer Screens

See Figure 4 - 3 on page 4 - 9 for the optional driver installer screen.
What to Install 4 - 3
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Table 4 - 1 - Driver Installation

Note that you need to install both the WLAN & Bluetooth drivers for the WLAN & Bluetooth Combo modules.

See Table D - 4, on page D - 21 for Windows 7 driver installation information.

Windows 8 Driver Page # Windows 8 Driver Page #

Chipset Page 4 - 7 PC Camera Module (Windows 8) - No driver is required for Windows 8

Video Page 4 - 7 Wireless LAN Module (Windows 8) Page 7 - 9

LAN Page 4 - 7 Bluetooth & WLAN Combo Module (Windows 8) Page 7 - 17

ExpressCard/Card Reader Page 4 - 7 Intel® Rapid Storage Technology Page 7 - 23

On Screen Display Page 4 - 7 Intel® Rapid Start Technology Driver Page 7 - 24

MEI Driver Page 4 - 7 Intel® Smart Connect Technology Page 7 - 32

Audio Page 4 - 7 Intel® Smart Connect Technology Page 7 - 38
4 - 4 What to Install



Drivers & Utilities

4

Manual Driver Installation
Click Browse CD/DVD (button) in the Drivers Install-
er application and browse to the executable file in the
appropriate driver folder.

Windows Update
After installing all the drivers make sure you enable
Windows Update in order to get all the latest security
updates etc. (all updates will include the latest hotfixes
from Microsoft). See “Windows Update” on page 4 -
8 for instructions.

Updating/Reinstalling Individual Drivers
If you wish to update/reinstall individual drivers it
may be necessary to uninstall the original driver.To do
this go to the Control Panel in the Windows OS and
double-click the Programs and Features icon (Pro-
grams > Uninstall a program). Click to select the
driver (if it is not listed see below) and click Uninstall,
and then follow the on screen prompts (it may be nec-
essary to restart the computer). Reinstall the driver as
outlined in this chapter.

If the driver is not listed in the Programs and Fea-
tures menu:

1. Go to the Control Panel.
2. Double-click Device Manager (Hardware and 

Sound > Devices and Printers > Device 
Manager).

3. Double-click the device you wish to update/reinstall 
the driver for (you may need to click “+” to expand 
the selection).

4. Click Driver (tab) and click the Update Driver or 
Uninstall button and follow the on screen prompts.
What to Install 4 - 5
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User Account Control
If a User Account Control prompt appears as part of
the driver installation procedure, click Continue or
Allow, and follow the installation procedure as direct-
ed.

Windows Security Message
If you receive a Windows security message as part of
the driver installation process. Just click “Install this
driver software anyway” or “Install” to continue the
installation procedure.

You will receive this message in cases where the driv-
er has been released after the version of Windows you
are currently using. All the drivers provided will have
already received certification for Windows.

New Hardware Found
If you see the message “New Hardware Found” dur-
ing the installation procedure (other than when out-
lined in the driver install procedure), click Cancel
to close the window, and follow the installation proce-
dure.


Driver Installation General Guidelines

The driver installation procedure outlined in this Chapter
(and in Chapter 7 Options & Modules), are accurate at
the time of going to press.

Drivers are always subject to upgrade and revision so
the exact procedure for certain drivers may differ slight-
ly. As a general guide follow the default on screen in-
structions for each driver (e.g. Next > Next > Finish)
unless you are an advanced user. In many cases a re-
start is required to install the driver.
4 - 6 What to Install
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Driver Installation Procedure
Insert the Device Drivers & Utilities + User’s Manual
disc into your DVD drive and click Install Drivers
(button).

Chipset
1. Click 1.Install Chipset Driver > Yes.
2. Click Next > Yes > Next > Next.
3. Click Finish to restart the computer.

Video
1. Click 2.Install VGA Driver > Yes.
2. Click Next > Yes > Next > Next.
3. Click Finish to restart the computer.

LAN
1. Click 3.Install LAN Driver > Yes. 
2. Click Next > Install > Finish.

ExpressCard/Card Reader
1. Click 4.Install Cardreader Driver > Yes.
2. Click Finish.

On Screen Display
1. Click 5.Install OSD Driver > Yes.
2. Click Next > Next.
3. Click Finish > Finish to restart the computer.

MEI Driver
1. Click 6.Install MEI Driver > Yes.
2. Click Next > Yes > Next.
3. Click Finish.

Audio
1. Click 7.Install Audio Driver > Yes. 
2. Click Next.
3. Click Finish to restart the computer.

Note that after installing the audio driver the system
will not return to the Drivers Installer screen. To in-
stall any of the optional drivers listed overleaf, eject
the Device Drivers & Utilities + User’s Manual disc
and then reinsert it (or double-click the disc icon in My
Computer), and click Option Drivers (button) to ac-
cess the optional driver menu.
What to Install 4 - 7
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(see overleaf)
Windows Experience Index
After the drivers are installed follow this procedure to
ensure an accurate rating from the Windows Experi-
ence Index:

1. Go to the Control Panel.
2. Click Performance Information and Tools 

(System and Security > System > Check the 
Windows Experience Index).

3. Click “Rate this computer”.
4. The computer will take a few minutes to assess 

the system performance.
5. Close the control panel.


Windows Update

After installing all the drivers make sure you enable Win-
dows Update in order to get all the latest security up-
dates etc., (all updates will include the latest hotfixes
from Microsoft).

To enable Windows Update make sure you are con-
nected to the internet:

1. Go to the Control Panel.
2. Click Windows Update (System and Security).
3. Click Check for updates (button).
4. The computer will now check for updates (you 

need to be connected to the internet).
5. Click Install now (button) to begin checking for the 

updates.
6. Click Install updates (button) to install the 

updates.
4 - 8 What to Install
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Optional Drivers
See the pages indicated in Table 4 - 1, on page 4 - 4 for the driver installation procedures for any modules in-
cluded in your purchase option. Insert the Device Drivers & Utilities + User’s Manual disc and click Option
Drivers (button) to access the optional driver menu.

Figure 4 - 3 - Optional Drivers
What to Install 4 - 9
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Chapter 5: BIOS Utilities

Overview
This chapter gives a brief introduction to the computer’s built-in software: 

If your computer has never been set up, or you are making important changes to the
system (e.g. hard disk setup), then you should review this chapter first and note the
original settings found in Setup. Even if you are a beginner, keep a record of the set-
tings you find and any changes you make. This information could be useful if your
system ever needs servicing.

There is one general rule: Don’t make any changes unless you are sure of what you
are doing. Many of the settings are required by the system, and changing them could
cause it to become unstable or worse. If you have any doubts, consult your service
representative.


BIOS Screens

Note that the BIOS
screens pictured on
these pages are intend-
ed for guidance in set-
ting up your system’s
BIOS.

BIOS versions are sub-
ject to constant change
and revision, therefore
your computer’s actual
screens may appear
slightly different from
those pictured on these
pages. 
Overview 5 - 1
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The Setup Utility
Each time you turn on the computer the system takes a few seconds to conduct a
POST, including a quick test of the on-board RAM (memory).

As the POST proceeds, the computer will tell you if there is anything wrong. If there
is a problem that prevents the system from booting, it will display a system summary
and prompt you to run Setup. 

If there are no problems, the Setup prompt will disappear and the system will load
the operating system. Once that starts, you can’t get into Setup without rebooting.

The Aptio Setup Utility tells the system how to configure itself and manage basic
features and subsystems (e.g. port configuration).

To enter Setup, turn on the computer and press F2 (give the system a few seconds
to enter Setup). If the Boot Logo is enabled the F2 on screen will be highlighted to
illustrate that the system is processing the request during the POST (or press F7 for
boot options). If you get a “Keyboard Error”, (usually because you pressed F2 too
quickly) just press F2 again.

If the computer is already on, reboot using the Ctrl + Alt + Delete combination and
then hold down F2 when prompted. The Setup main menu will appear.

To see the boot options press F7 and choose your preferred boot device.


BIOS Settings 

Warning

Incorrect settings can
cause your system to
malfunction. To correct
mistakes, return to Set-
up and restore the Pre-
vious Values with
<F2>, or Optimized De-
faults with <F3>.

UEFI Boot & POST

When UEFI Boot is en-
abled, then the prompts
to press F2 or F7 will
not appear. However
you can still press F2 to
enter the setup, or F7 to
choose the preferred
boot device, if you press
the key immediately the
system boots up.
5 - 2 The Setup Utility
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Failing the POST
Errors can be detected during the POST. There are two categories, “fatal” and “non-
fatal”.

Fatal Errors
These stop the boot process and usually indicate there is something seriously wrong
with your system. Take the computer to your service representative or authorized
distributor/supplier as soon as possible.

Non-Fatal Errors
This kind of error still allows you to boot. You will get a message identifying the
problem (make a note of this message!) and you can then press F7 (the F7 on screen
will be highlighted to illustrate that the system is processing the request) for boot
options.

Press F2 (give the system a few seconds to enter Setup; the F2 on screen will be
highlighted to illustrate that the system is processing the request) to run the Setup
program and try to correct the problem. If you still get an error message after you
change the setting, or if the “cure” seems even worse, call for help.
The Setup Utility 5 - 3
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Setup Screens
The following pages contain additional advice on portions of the Setup. Along the
top of the screen is a menu bar with menu headings. When you select a heading, a
new screen appears. Scroll through the features listed on each screen to make chang-
es to Setup.

Instructions on how to navigate each screen are in the box at the bottom right side of
the screen.

If these tools are confusing, press F1 to call up a General Help screen, and then use
the arrow keys to scroll up or down the page.

The Item Specific Help on the upper right side of each screen explains the highlight-
ed item and has useful messages about its options.

If you see an arrow  next to an item, press Enter to go to a sub-menu on that sub-
ject. The sub-menu screen that appears has a similar layout, but the Enter key may
execute a command.


Setup Menus

The Setup menus
shown in this section are
for reference only. Your
computer’s menus will
indicate the configura-
tion appropriate for your
model and options.

Figure 5 - 1
Navigation Menu
5 - 4 The Setup Utility
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Main Menu

System Time & Date (Main Menu)
The hour setting uses the 24-hour system (i.e., ØØ = midnight; 13 = 1 pm). If you
can change the date and time settings in your operating system, you will also change
these settings. Some applications may also alter data files to reflect these changes.

Figure 5 - 2
Main Menu
Main Menu 5 - 5
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SATA Port # (Main Menu)
Pressing Enter opens the sub-menu to show the configuration of a optical Device/
HDD on the computer’s SATA Ports.

System/Extended Memory: (Main Menu)
This item contains information on the system memory, and is not user configurable.
The system will auto detect the amount of memory installed.

MB Series / BIOS Revision / KBC/EC firmware Revision
This item contains information on the BIOS version etc., and is not user configu-
rable.
5 - 6 Main Menu
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Advanced Menu

Advanced Chipset Control (Advanced Menu)
The sub-menu here allows you to adjust the Bluetooth Power Setting.

Figure 5 - 3
Advanced Menu
Advanced Menu 5 - 7
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Bluetooth Power Setting (Advanced Menu > Advanced Chipset Control)
You can adjust the Bluetooth module power setting to your preference. The default
setting (Disabled) will see the Bluetooth module powered off when the system is
started up or restarted. Enabling the power setting will have the module retain the
last power status (on or off) before any restart or shut down.

Intel Smart Connect Technology (Advanced Menu)
Smart Connect is a technology that makes checks on web applications that are
open, when the computer is in Sleep mode, and thus allows updates to be made with-
out the need to turn the computer on. The sub-menu here allows you to enable/dis-
able the technology itself (ISCT Configuration). See “Intel® Smart Connect
Technology” on page 7 - 93.

Intel(R) Rapid Start Technology (Advanced Menu)
Enable/disable Intel(R) Rapid Start Technology from this menu. The rapid start
hibernation mode can resume power within 5 to 6 seconds and can remember your
computer's state with zero power.

Intel Anti-Theft Technology (Advanced Menu)
Anti-Theft Technology, which is built-in to the processor of the computer, allows
system administrators to render your computer useless to thieves by sending a poi-
son pillencrypted SMS message over a 3G network etc. Administrators can also re-
motely unlock a recovered computer quickly, or direct the system to send location
information (GPS coordinates) back to a central server.
5 - 8 Advanced Menu
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SATA Mode Selection (Advanced Menu)
You can configure SATA (Serial ATA) control to operate in IDE (native/compati-
ble), AHCI (Advanced Host Controller Interface) modes from this menu. The
SATA Mode should be set BEFORE installing an operating system, and after you
have backed up all necessary files and data (see sidebar).

Boot Logo (Advanced Menu)
Use this menu item to enable/disable the Boot Logo screen at system startup. If you
disable the Boot Logo you will not see the F2 Enter Setup or F7 Boot Options
prompts on the screen, however you can still press these keys, while the boot screen
is displayed, to perform the Enter Setup or Boot Option functions.

Power On Boot Beep (Advanced Menu)
Use this menu item to enable/disable the beep as the computer starts up.

Battery Low Alarm Beep (Advanced Menu)
Use this menu item to enable/disable the battery low alarm beep.

Super IO Configuration (Advanced Menu)
Use this menu to enable/disable and configure the serial (RS-232) ports to your re-
quirements. Change Settings allows you to change the IO and IRQ settings, and De-
vice Mode allows you to set the ports to normal or high speed modes.


SATA Mode 

Selection

If you have installed the
Windows OS with ei-
ther IDE or AHCI mode
enabled, DO NOT dis-
able the set mode (if you
wish to disable the set
mode you will need to
reinstall the Windows
OS).
Advanced Menu 5 - 9
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Security Menu

Password on boot (Security Menu)
Specify whether or not a password should be entered to boot the computer (you may
only set a password on boot if a supervisor password is enabled). If “Enabled”
is selected, only users who enter a correct password can boot the system (see the
warning in the sidebar).


Security Menu

The changes you make
here affect the access
to the Setup utility itself,
and also access to your
machine as it boots up
after you turn it on.
These settings do not
affect your machine or
network passwords
which will be set in your
software OS.

Figure 5 - 4
Security Menu
5 - 10 Security Menu
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Set Supervisor Password (Security Menu)
You can set a password for access to the Aptio Setup Utility. This will not affect
access to the computer OS (only the Aptio Setup Utility). If you set a supervisor
password you can then add a user password.

Set User Password (Security Menu)
You can set a password for user mode access to the Aptio Setup Utility. This will
not affect access to the computer OS, (only the Setup utility) unless you choose to
set a Password on Boot (see below). Many menu items in the Aptio Setup Utility
cannot be modified in user mode. You can only set the user password after you
have set the supervisor password.

Note: To clear existing passwords press Enter and type the existing password, then
press Enter for the new password (without typing any password entry) and Enter
again to confirm the password clearance.

Secure Boot (Advanced Menu)
Secure Boot prevents unauthorized operating systems and software from loading
during the startup process. Secure Boot is available as a menu option if you have
Windows 8 set as your operating system, and have enabled UEFI Boot (see “Boot
Menu” on page 5 - 12). Enabling Secure Boot will bring up the Secure Boot Mode
menu to enable you to configure Secure Boot as Standard (with a fixed secure boot
policy), or Custom (which enables you to make changes to the Image Execution
Policy and Key Management database). 


Password Warning

If you set a boot pass-
word (Password on boot
is “Enabled“), NEVER
forget your password. 

The consequences of
this could be serious. If
you cannot remember
your boot password you
must contact your ven-
dor and you may lose all
of the information on
your hard disk.
Security Menu 5 - 11
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Boot Menu

When you turn the computer on it will look for an operating system (e.g. Windows
7) from the devices listed in this menu, and in this priority order. If it cannot find
the operating system on that device, it will try to load it from the next device in the
order specified in the Boot Option Priorities. Item specific help on the right is
available to help you move devices up and down the order.


BIOS Settings 

Warning

Incorrect settings can
cause your system to
malfunction. To correct
mistakes, return to Set-
up and restore the Pre-
vious Values with
<F2>, or Optimized De-
faults with <F3>.

UEFI Boot & POST

When UEFI Boot is en-
abled, then the prompts
to press F2 or F7 will
not appear. However
you can still press F2 to
enter the setup, or F7 to
choose the preferred
boot device, if you press
the key immediately the
system boots up.
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Boot Option Priorities (Boot Menu)
Use the arrow keys to move up and down the menu, and press Enter to select a device
from the Boot Option # list. You can go to either CD/DVD ROM Drive Priorities,
Hard Drive BBS Priorities or Network Device BBS Priorities and press Enter to
select a device (the selected device will be highlighted in white).

OS Select (Boot Menu)
This item tells allows you to set the operating system you intend to use. This item
should be set before you install an operating system.

UEFI Boot (Boot  Menu > OS Select)
Enable/disable UEFI Boot from this menu. The Unified Extensible Firmware Inter-
face (UEFI) specification provides a clean interface between operating systems and
platform firmware at boot time. In contrast to BIOS, UEFI defines a set of standard
boot and runtime services. The Network Stack item will be enabled as an option un-
der UEFI Boot.
Boot Menu 5 - 13
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Exit Menu

Click Save Changes and Reset to save all changes made. Choosing to Discard
Changes, or Exit Discarding Changes, will wipe out any changes you have made
to the Setup. You can also choose Load Setup Defaults to restore the original Setup
defaults and return the Setup to its original state, and erase any previous changes you
have made in a previous session.

Figure 5 - 5
Exit Menu


BIOS Screens

Note that the BIOS
screens pictured on
these pages are intend-
ed for guidance in set-
ting up your system’s
BIOS.

BIOS versions are sub-
ject to constant change
and revision, therefore
your computer’s actual
screens may appear
slightly different from
those pictured on these
pages. 
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Chapter 6: Upgrading The Computer

Overview
This chapter contains information on upgrading the computer. Follow the steps out-
lined to make the desired upgrades. If you have any trouble or problems you can con-
tact your service representative for further help. Before you begin you will need:

• A small crosshead or Phillips screwdriver
• A small regular slotted (flathead) screwdriver
• An antistatic wrist strap

Before working with the internal components you will need to wear an antistatic
wrist strap to ground yourself because static electricity may damage the compo-
nents.

The chapter includes:

• Removing the Rear Top Cover
• Upgrading the Hard Disk Drive
• Upgrading the System Memory (RAM)

Please make sure that you review each procedure before you perform it.


Warranty Warning

Please check with your
service representative
before undertaking any
upgrade procedures to
find out if this will VOID
your warranty.
Overview 6 - 1
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When Not to Upgrade
These procedures involve opening the system’s case, adding and sometimes replac-
ing parts.

You should not perform any of these upgrades if:

• Your system is still under warranty or a service contract
• You don’t have all the necessary equipment 
• You’re not in the correct environment
• You doubt your abilities

Under any of these conditions, contact your service representative to purchase or re-
place the component(s).


Power Safety 

Warning

Before you undertake
any upgrade proce-
dures, make sure that
you have turned off the
power, and disconnect-
ed all peripherals and
cables (including tele-
phone lines and power
cord). 


Removal Warning

When removing any cover(s) and screw(s) for the purposes of device upgrade, remember
to replace the cover(s) and screw(s) before turning restoring power to the system.

Also note the following when the cover is removed:

• Hazardous moving parts.
• Keep away from moving fan blades.
6 - 2 Overview
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Removing the Rear Top Cover
Before undertaking any upgrade procedure it is necessary to remove the rear top
cover to access the components.

1. Turn off the computer and disconnect all cables and peripherals.
2. Carefully place the computer flat with the LCD facing down (make sure you cover 

the LCD to avoid scratches) so that you may access the rear cover.
3. Remove screws  - .

Figure 6 - 1
Rear Top Cover 

Screws

1 4

21 3 4
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4. Slide the rear top cover until the arrow is aligned with the unlock icon .

Figure 6 - 2
Rear Top Cover 

Unlock

5

5
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5. When the arrow is aligned with the unlock icon you can remove the rear top 
cover .

Figure 6 - 3
Rear Top Cover 

Removal

6

6
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Upgrading the Hard Disk Drive
The hard disk drive can be taken out to accommodate other 2.5" serial (SATA) hard
disk drives with a height of 9.5mm (h) (see “Storage” on page C - 3). Follow your
operating system’s installation instructions, and install all necessary drivers and util-
ities (as outlined in “Driver Installation Procedure” on page 4 - 5), when setting up
a new hard disk.

1. Remove the rear cover (see “Removing the Rear Top Cover” on page 6 - 3).
2. Remove screws  - .


HDD System 

Warning

New HDD’s are blank. Be-
fore you begin make sure:
You have backed up any
data you want to keep from
your old HDD.
You have all the CD-ROMs
and FDDs required to in-
stall your operating system
and programs.
If you have access to the in-
ternet, download the latest
application and hardware
driver updates for the oper-
ating system you plan to in-
stall. Copy these to a
removable medium.

Figure 6 - 4
Hard Disk Screws

1 3

2

1

3


Hard Disk Slot

Make sure you install the hard disk
into the lower slot on the main-
board.
6 - 6 Upgrading the Hard Disk Drive



Upgrading The Computer

6

3. Slide the hard disk in the direction of arrow , and then slide it in the direction of 
arrow  to remove it.

4. Remove the adhesive hard disk cover .

5. Reverse the process to install a new hard disk.

Figure 6 - 5
Hard Disk Assembly 

Removal

Figure 6 - 6
Hard Disk Cover 

Removal

4
5

5

4

6

6
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Upgrading the System Memory (RAM)
The computer has two memory sockets for 204 pin Small Outline Dual In-line (SO-
DIMM) DDRIII (DDR3) type memory modules (see “Memory” on page C - 2 for
details of supported module types). 

The total memory size is automatically detected by the POST routine once you turn
on your computer.

1. Remove the rear cover (see “Removing the Rear Top Cover” on page 6 - 3).
2. The RAM is located at point .


Contact Warning

Be careful not to touch
the metal pins on the
module’s connecting
edge. Even the cleanest
hands have oils which
can attract particles, and
degrade the module’s
performance.

Figure 6 - 7
RAM Location

1

1
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3. Gently pull the two release latches on the sides of the memory socket in the 
direction indicated by the arrows (  & ) in Figure 6 - 8.

4. The RAM module will pop-up, and you can remove it.
5. Pull the latches to release the second module if necessary.

2 2

2 3

2 3

Figure 6 - 8
RAM Module 

Release
Upgrading the System Memory (RAM) 6 - 9
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6. Insert a new module holding it at about a 30° angle and fit the connectors firmly 
into the memory socket (see sidebar note if you are inserting a single module).

7. The module’s pin alignment will allow it to only fit one way. Make sure the module 
is seated as far into the slot as it will go. DO NOT FORCE the module; it should fit 
without much pressure.

8. Press the module in and down towards the mainboard until the slot levers click into 
place to secure the module.

9. Replace the module bay cover and screws.
10. Restart the computer to allow the BIOS to register the new memory configuration 

as it starts up.

Figure 6 - 9
RAM Module 

Removal


Single Memory 

Module Installation

If your computer has a
single memory module,
then insert the module
into the Channel 0
(JDIMM1) socket. In this
case this is the upper
memory socket (the
socket furthest from the
mainboard).
6 - 10 Upgrading the System Memory (RAM)



Upgrading The Computer

6

Upgrading the Processor
If you want to upgrade your computer by replacing the existing processor with a fast-
er/new one you will need to contact your customer service representative. We rec-
ommend that you do not do this yourself, since if it is done incorrectly you may
damage the processor or mainboard.


Warranty

The CPU is not a user
serviceable part. Ac-
cessing the CPU in any
way, may violate your
warranty.

Unauthorized tampering
with the HDD may also
violate your warranty.
Upgrading the System Memory (RAM) 6 - 11
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Chapter 7: Modules & Options

Overview
This chapter contains information on the following modules, which may come with
your computer, depending on the configuration purchased. If you are unsure please
contact your service representative.

• PC Camera Module (Windows 8)
• Wireless LAN Module (Windows 8)
• Bluetooth & WLAN Combo Module (Windows 8)
• Intel® Rapid Storage Technology
• Intel® Rapid Start Technology Driver
• Intel® Smart Connect Technology
• Intel® Wireless Display Application

For information on the Windows 7 operating system see Appendix D.
Overview 7 - 1
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PC Camera Module (Windows 8)
When the PC Camera application is run the LED indicator to the left of the camera
will be illuminated in red (see  Figure 1 - 2 on page 1 - 6). Note that you need to
use the Camera app in Windows 8 to take pictures and capture video.

No camera driver installation. is required for Windows 8. See “PC Camera Module
(Windows 7)” on page D - 27 for Windows 7 configuration information.

2
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PC Camera Audio Setup
If you wish to capture video & audio with your camera, it is necessary to setup the
audio recording options in Windows.

1. Go to the Control Panel.
2. Click Sound  (Hardware and Sound) and click Recording (tab).
3. Right-click, hold and release Microphone (Realtek High Definition Audio) and 

make sure the item is not disabled.
4. Double-click Microphone (or select Properties from the right-click menu).
5. Click Levels (tab), and adjust the Microphone and Microphone Boost sliders to 

the level required.
6. Click OK and close the control panels.

Figure 7 - 1
Audio Setup for PC 

Camera

Right-click
PC Camera Module (Windows 8) 7 - 3



Modules & Options

7

Metro UI Camera App
1. Run the Camera app from the Metro UI by clicking on the Camera app icon .
2. The camera interface is a translucent app bar with three buttons.

• Camera options:. Click this button to open a window with three main options:

Figure 7 - 2
Camera App Bar

Figure 7 - 3
Camera Options


Camera Options

• Resolution (determined by 
the camera spec) 

• Audio device (select 
microphone to use)

• Video Stabilization (a tog-
gle based on spec of the 
camera)
7 - 4 PC Camera Module (Windows 8)
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You can also click on More to adjust Brightness, Contrast and Flicker (if you 
find that the video screen in the camera program is flickering, you can try to 
adjust the setting here).

 

• Timer: This button will start a three second countdown before the system takes 
a still photo or video recording starts.

• Video Mode: This button toggles between still photo mode (transparent button 
) and video recording mode (highlighted white button ).

Figure 7 - 4
More Camera 

Options
PC Camera Module (Windows 8) 7 - 5
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Taking Pictures/Capturing Video
1. Run the Camera app from the Metro UI by clicking on the Camera app icon .
2. Click to select the timer if you require a countdown before capture.
3. Click to select either photo or video modes.
4. Click in the main window to take a picture or start video capture (if video capture 

begins a timer will appear in the bottom right corner of the screen).
5. To stop video capture click the main window again.
6. Captured photos and videos will be saved to a Camera Roll folder within the 

Picture folder in Libraries.

Figure 7 - 5
Libraries - Pictures
7 - 6 PC Camera Module (Windows 8)
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7. A scroll arrow will appear on the left side of the screen after any pictures/videos 
have been captured.

8. Click the arrows (on either side of the screen) to browse through the captured 
photos/video, and back to the Camera app.

9. Clicking on a captured photo will bring up an app bar with Crop and Delete 
buttons.

10. Use the handles to Crop any captured picture, and click OK to save the changes 
made.

11. Click Delete to delete any captured photo (note that no prompt will appear to 
confirm the delete).

12. Right-click any captured video to bring up app bar with Trim and Delete buttons.

13. Use the buttons at either end of the slider to adjust the video length and click OK to 
save the changes made.

Figure 7 - 6
Crop & Delete 

Buttons 
(for Still Photos)

Figure 7 - 7
Trim & Delete 

Buttons 
(for Video Files)
PC Camera Module (Windows 8) 7 - 7
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Reducing Video File Size
Note that capturing high resolution video files requires a substantial amount of disk
space for each file. After recording video, check the video file size (right-click the
file and select Properties) and the remaining free space on your hard disk (go to My
Computer, right-click the hard disk, and select Properties). If necessary you can
remove the recorded video file to a removable medium e.g. CD, DVD or USB Flash
drive.

Note that the Windows 8 system requires a minimum of 16GB (32-bit) or 20GB (64-
bit) of free space on the C: drive system partition. In order to prevent system prob-
lems it is recommended that you move any large sized captured video file to a loca-
tion other than the C: drive, or reduce video resolution (see below).

To Reduce Video Resolution Output Size:

1. Run the Camera app.
2. Click the Video resolution dropbox and select a lower resolution size in order to 

reduce the captured file size.
3. Note that reducing video resolution will affect the video quality.
7 - 8 PC Camera Module (Windows 8)
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Wireless LAN Module (Windows 8)
If you have included an Intel® or 3rd Party module in your purchase option see the
following pages for driver installation and configuration information or see “Wire-
less LAN Module (Windows 7)” on page D - 35 for Windows 7 configuration infor-
mation.

Make sure you install the drivers in the order indicated in Table 4 - 1, on page 4 - 4.

Note that you need to install both the WLAN & Bluetooth drivers for the WLAN
& Bluetooth Combo modules.
Wireless LAN Module (Windows 8) 7 - 9
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3rd Party 802.11b/g/n Driver Installation
1. If you see the message “Found New Hardware” click Cancel to close the 

window.
2. Insert the Device Drivers & Utilities + User’s Manual disc into the DVD 

drive. 
3. Click Option Drivers (button).
4. Click 1.Install WLAN Driver > Yes.
5. Choose the language you prefer and click Next.
6. Click Next.
7. Click Finish to restart the computer.

Note: The operating system is the default setting for Wireless LAN control in Win-
dows 8 (see page 7 - 12). See “Wireless LAN Module (Windows 7)” on page D - 35
for Windows 7 configuration information.
7 - 10 Wireless LAN Module (Windows 8)
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Intel® WLAN Driver Installation
1. If you see the message “Found New Hardware” click Cancel to close the 

window.
2. Insert the Device Drivers & Utilities + User’s Manual disc into the DVD 

drive. 
3. Click Option Drivers (button).
4. Click 1.Install WLAN Driver > Yes.
5. Click Next > Next.
6. Click the button to accept the license and click/tap Next.
7. Click Typical > Install.
8. Click Finish.
Wireless LAN Module (Windows 8) 7 - 11
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WLAN Configuration in Windows 8
You can configure a wireless connection using one of the following options before
configuration begins.

Charms Bar
1. Go to the Charms Bar.
2. Select Settings and then click/tap the WiFi icon (it should read Available under 

the icon).
3. A list of available access points will appear.

Figure 7 - 8
WiFi Settings 

(Charms Bar) & 
Networks
7 - 12 Wireless LAN Module (Windows 8)
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4. Double-click an access point to connect to it (or click it and click Connect).
5. Enter a network security key (password) if required, and click Next.
6. You can choose to share or connect to devices or not.
7. When you are connected to the network access point it will display the Connected 

icon .
8. Select any connected network and click Disconnect  to disconnect from a 

connected access point.

Figure 7 - 9
Networks 

Connected / 
Disconnect
Wireless LAN Module (Windows 8) 7 - 13
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Desktop Mode
1. Switch to the Windows Desktop (click the app or use the Windows logo key  + 

D key combination).
2. Click the wireless icon  in the notification area of the taskbar.
3. A list of available access points will appear.
4. Double-click an access point to connect to it (or click it and click Connect).
5. Enter a network security key (password) if required, and click Next.
6. You can choose to share or connect to devices or not.
7. Select any connected network and click Disconnect to disconnect from a 

connected access point.

Figure 7 - 10
Windows Desktop 

Taskbar Notification 
Area WLAN 
Connection
7 - 14 Wireless LAN Module (Windows 8)
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Control Panel
If you are in Category View do the following (see over for Icon View):

1. Open the Control Panel.
2. Click the Network and Internet control panel.
3. Click Connect to a network.

4. A list of available access points will appear.
5. Double-click an access point to connect to it (or click it and click Connect).
6. Enter a network security key (password) if required, and click Next.
7. You can choose to share or connect to devices or not.
8. Select any connected network and click Disconnect to disconnect from a 

connected access point.

Figure 7 - 11
Network and 

Internet Control 
Panel
Wireless LAN Module (Windows 8) 7 - 15
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If you are in Icon View do the following:

1. Open the Control Panel.
2. Click Network and Sharing Center.
3. Click Change Adapter Settings.
4. Double-click Wi-Fi.

5. A list of available access points will appear.
6. Double-click an access point to connect to it (or click it and click Connect).
7. Enter a network security key (password) if required, and click Next.
8. You can choose to share or connect to devices or not.
9. Select any connected network and click Disconnect to disconnect from a 

connected access point.

Figure 7 - 12
Network and 

Sharing Center 
Control Panel
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Bluetooth & WLAN Combo Module (Windows 8)
If your purchase option includes the Combination Wireless LAN & Bluetooth
module (either Intel® or 3rd Party) then install the driver as instructed overleaf.
See “Bluetooth & WLAN Combo Module (Windows 7)” on page D - 54 for Win-
dows 7 configuration information.


Bluetooth Data Transfer

Note that the transfer of data between the computer and a Bluetooth enabled device is supported
in one direction only (simultaneous data transfer is not supported). Therefore if you are copying
a file from your computer to a Bluetooth enabled device, you will not be able to copy a file from
the Bluetooth enabled device to your computer until the file transfer process from the computer
has been completed.
Bluetooth & WLAN Combo Module (Windows 8) 7 - 17
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3rd Party Bluetooth (V4.0) Combo Driver Installation
Note this driver is required for the 3rd Party combo Bluetooth and WLAN module
(Bluetooth V4.0) only.

1. If you see the message “Found New Hardware” click Cancel to close the 
window.

2. Insert the Device Drivers & Utilities + User’s Manual disc into the DVD 
drive. 

3. Click Option Drivers (button).
4. Click 2.Install Combo BT Driver > Yes.
4. Click Next.
5. Click Finish to restart the computer.
6. See “Bluetooth Configuration in Windows 8” on page 7 - 20 for configu-

ration instructions.


High Speed Bluetooth 

Data Transfer

The Combination Wire-
less LAN & Bluetooth
module supports high
speed data transfer. How-
ever to achieve such
transfer speeds, both de-
vices must support
high speed data trans-
fer.

To obtain high speed
data transfer make sure
that both the WLAN and
Bluetooth modules are
powered on.

Check your Bluetooth
compatible device’s doc-
umentation to confirm it
supports high speed data
transfer.
7 - 18 Bluetooth & WLAN Combo Module (Windows 8)
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Intel Bluetooth Combo Driver Installation
Note this driver is required only for the Intel combo Bluetooth and WLAN module
only.

1. If you see the message “Found New Hardware” click Cancel to close the 
window.

2. Insert the Device Drivers & Utilities + User’s Manual disc into the DVD 
drive.

3. Click Option Drivers (button).
4. Click 2.Install Combo BT Driver > Yes.
5. Click Next > Next.
6. Click the button to accept the license and click Next.
7. Click Next > Finish.
8. See “Bluetooth Configuration in Windows 8” on page 7 - 20 for configu-

ration instructions.


High Speed Bluetooth 

Data Transfer

The Combination Wire-
less LAN & Bluetooth
module supports high
speed data transfer. How-
ever to achieve such
transfer speeds, both de-
vices must support
high speed data trans-
fer.

To obtain high speed
data transfer make sure
that both the WLAN and
Bluetooth modules are
powered on.

Check your Bluetooth
compatible device’s doc-
umentation to confirm it
supports high speed data
transfer.
Bluetooth & WLAN Combo Module (Windows 8) 7 - 19
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Bluetooth Configuration in Windows 8
You can configure a Bluetooth connection as below.

Desktop Mode
1. Switch to the Windows Desktop (click the App or use the Windows logo key  + 

D key combination).
2. Click the notification area of the taskbar and double-click the Bluetooth icon  (or

click and select Show Bluetooth Devices).
3. The Devices item in PC Settings will appear.

OR
Charms Bar
1. Go to the Charms Bar.
2. Select Settings and then click/tap Change PC Settings.
3. The Devices item in PC Settings will appear.

\

Figure 7 - 13
Bluetooth Taskbar 
Icon & Change PC 
Settings (Charms 

Bar -Settings)
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4. Click Add a Device.
5. Double-click the device you want to pair with the computer.

6. On first connection the computer will provide you with a pairing code to be entered 
onto the device.

7. Enter the code into your Bluetooth enabled device and click Yes on the computer 
to complete the pairing.

Figure 7 - 14
PC Settings 

(Devices) - Add A 
Device)

Figure 7 - 15
Enter the Passcode
Bluetooth & WLAN Combo Module (Windows 8) 7 - 21
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To Make your Computer Discoverable to Bluetooth Devices
1. Switch to the Windows Desktop (click/tap the app or use the Windows logo key  

+ D key combination).
2. Click the notification area of the taskbar, click/tap the Bluetooth icon  and click

Open Settings.
3. Click Options, and make sure that Allow Bluetooth devices to find this 

computer check box (Discovery) has a tick inside it.
4. Make sure that the Alert me when a new Bluetooth device wants to connect 

check box (Connections) has a tick inside it, if you want to be notified when a 
Bluetooth device wants to connect.

Figure 7 - 16
Bluetooth Settings
7 - 22 Bluetooth & WLAN Combo Module (Windows 8)
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Intel® Rapid Storage Technology
Install the Intel Rapid Storage Technology to support your SATA drive if set up in
AHCI mode in the BIOS (see “SATA Mode Selection (Advanced Menu)” on
page 5 - 9).

IRST Driver Installation
1. Insert the Device Drivers & Utilities + User’s Manual disc into the DVD 

drive.
2. Click Option Drivers (button).
3. Click 3.Install IRST Driver > Yes.
4. Click (click the box to Install Intel® Control Center) to Next > Yes > 

Next > Next.
5. Click Finish to restart the computer.
Intel® Rapid Storage Technology 7 - 23
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Intel® Rapid Start Technology Driver
Intel(R) Rapid Start Technology can resume power from Hibernation within 5 to
6 seconds and can remember your computer's previous state with zero power.

System Requirements to support Intel® Rapid Start Technology:
• Rapid Start Technology should be enabled in the BIOS (see ““Intel(R) Rapid 

Start Technology (Advanced Menu)” on page 5 - 8).
• Intel Rapid Storage Technology software installed. 
• A Solid State Drive (SSD) with a minimum capacity of 18.6GB.

See overleaf for instructions on enabling Intel® Rapid Start Technology and see
“Intel Smart Connect & Intel Rapid Start Technology” on page 7 - 36 for informa-
tion on configuring Rapid Start and Smart Connect Technology.
7 - 24 Intel® Rapid Start Technology Driver
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Intel® Rapid Start Technology Configuration
1. Enable/disable Intel(R) Rapid Start Technology from the BIOS (see “Intel(R) 

Rapid Start Technology (Advanced Menu)” on page 5 - 8).
2. Go the Windows Control Panel and double-click Administrative Tools (System 

and Security)> Computer Management > Storage > Disk Management
3. Right-click the SSD and select Shrink Volume from the menu.

Figure 7 - 17
Computer 

Management 
(Shrink SSD 

Volume)

Shrink Volume
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4. Enter the figure, which should be equal to amount of system memory (RAM) 
in your computer, in “Enter the amount of space to shrink in MB”.

5. Click Shrink (any unallocated file space may be formatted for storage use).

Figure 7 - 18
Shrink Volume 

Size


Memory Size (Amount of Space to Shrink)

The figure entered in the “Enter the amount of space to shrink in MB” field above should be equal
to the amount of system memory in your computer. In the example above the system memory is 4GB
(1024MB * 4 = 4096GB). If you are unsure of your total system memory (RAM) then go to System
control panel (System and Security) and check Installed memory (RAM). The memory size will be dis-
played in GB so convert by multiplying the GB figure by 1024 to get the total in MB (e.g. 8GB =
8192MB).
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6. Run the Desktop app and right-click the lower left hot corner (or use the Windows 
Logo Key  + X key combination) and select Command Prompt (Admin).

7. Type “DISKPART”.
8. At the DISKPART command type “list disk”.

Figure 7 - 19
Search for CMD 

Prompt

Figure 7 - 20
Diskpart - List Disk
Intel® Rapid Start Technology Driver 7 - 27
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9. Type “select disk #” (# is disk number where you want to create the store 
partition, so refer to the results obtained from "list disk" for exact disk number).

10. The message “Disk # is now the selected disk.” will appear.

11. Type “create partition primary”.
12. A “DiskPart succeeded in creating the specified partition.” message should 

appear.

Figure 7 - 21
Diskpart - Select 

Disk #

Figure 7 - 22
Diskpart - Create 

Partition
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13. Type “detail disk”.

14. Type “select Volume #” (# is volume of your storage partition so refer to results 
obtained from "detail disk" for the exact volume number).

15. The message “Volume # is now the selected volume.” will appear.

Figure 7 - 23
Diskpart - Detail 

Disk

Figure 7 - 24
Diskpart - Select 

Volume #
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16. Type “set id=84 override” (the id must be set to 84).

17. The message “DiskPart successfully set the partition ID.” will appear.
18. Close the CMD window.
19. Go the Windows Control Panel and double-click Administrative Tools (System 

and Security)> Computer Management > Storage > Disk Management.
20. The disk partition should read Healthy Hibernation Partition.

21. Restart the computer (install the driver as instructed overleaf).

Figure 7 - 25
Diskpart - Set 
id=84 Override

Figure 7 - 26
Computer 

Management 
(Healthy 

Hibernation 
Partition) Healthy (Hibernation Partition)
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Intel® Rapid Start Technology Driver Installation
1. Insert the Device Drivers & Utilities + User’s Manual disc into the DVD 

drive.
2. Click Option Drivers (button).
3. Click 4.Install Rapid Start Driver > Yes.
4. Click Next > Next > Yes > Next > Next.
5. Click Finish to restart the computer.
Intel® Rapid Start Technology Driver 7 - 31
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Intel® Smart Connect Technology
Intel® Smart Connect Technology periodically, and briefly, wakes the computer
from Sleep mode in order to update information for certain applications (e.g. to get
mail from Microsoft Outlook) as required. These updates can therefore be made
without having to turn the computer on, and applications will be up to date when the
computer resumes from Sleep mode (make sure that Intel Smart Connect Technol-
ogy is enabled in the BIOS - see “Intel Smart Connect Technology (Advanced
Menu)” on page 5 - 8).

Note that the applications need to be on and running when the computer enters
Sleep mode in order to get updates.

Intel® Smart Connect Technology Driver Installation
1. Insert the Device Drivers & Utilities + User’s Manual disc into the DVD 

drive.
2. Click Option Drivers (button).
3. Make sure that Intel Smart Connect Technology is enabled in the BIOS - 

see “Intel Smart Connect Technology (Advanced Menu)” on page 5 - 8.
4. Click 5.Install ISCT Driver > Yes.
5. Click Next.
6. Click the button to accept the license agreement and click Next.
7. Click Next > Install > Finish.
8. Click Yes to restart the computer.


Intel® Smart Connect 
Technology System 

Requirements

Note that in order to sup-
port Intel® Smart Con-
nect Technology your
system will need to have
the item enabled in the
BIOS (see page 5 - 8).

In addition only the follow-
ing WLAN modules sup-
port this feature:

Intel® Centrino® Wire-
less-N 2230
Intel® Centrino® Wire-
less-N 135
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Intel® Smart Connect Technology Configuration
1. Access the Intel(R) Smart Connect Technology application from the Start menu.
2. Click Basic (tab) and adjust the slider to set the update frequency (note that the 

slider balances between “More Frequent Updates” and “More Battery Life”).
3. In order to update any applications, they will need to be on and running when the 

computer enters Sleep mode.

Figure 7 - 27
iSCT Basic
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4. Click Advanced (tab) to access the Extended Power Savings settings.
5. Extended Power Savings allows you to set a time period during which the 

computer will update less often (e.g. at night while you are asleep or whenever you 
are at work).

6. Updates set during this time period will be performed every two hours, and this will 
override the settings selected in the Basic tab in order to conserve power 
consumption.

Figure 7 - 28
iSCT Advanced
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7. Click the Help tab and click Topics to access the main Help menu.


Intel WLAN Modules

If your purchase option
includes an Intel WLAN
module, (with Intel’s
PROSet Wireless Con-
nection Utility in-
stalled), Intel® Smart
Connect Technology
will search for WiFi net-
works around you that
you have previously ac-
cessed. 

If no known WiFi net-
works are found, your
computer will not update
again until it recognizes
a known WiFi network.

Figure 7 - 29
iSCT Help
Intel® Smart Connect Technology 7 - 35
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Intel Smart Connect & Intel Rapid Start Technology
Intel® Smart Connect Technology wakes the computer from Sleep mode in order
to update application information. Intel(R) Rapid Start Technology can resume
power from Hibernation within 5 to 6 seconds and can remember your computer's
previous state with zero power. Intel(R) Rapid Start Technology sends the com-
puter into Hibernate mode and skips the Sleep mode. Therefore if Rapid Start is en-
abled, Smart Connect will be unable to wake the system as Sleep mode has been
bypassed. In order to configure your system to run Smart Connect you will either
need to disable or delay the system from running Rapid Start.

Disabling or Delaying Rapid Start Technology
1. Run Intel(R) Rapid Start Technology Manager from the Start menu or double-

click the icon  in the notification area of the taskbar.

Figure 7 - 30
Intel® Rapid Start 

Technology 
Manager Access
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2. Disable Intel Rapid Start Technology by clicking the Off button, and clicking Save.
OR

3. Click Timer to make sure it is on, and adjust the slider to select a time to delay 
entering Rapid Start from running, and click Save.

Figure 7 - 31
Intel® Rapid Start 

Technology 
Manager Settings
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Intel® Wireless Display Application
The Intel® Wireless Display Application (requires Intel® Centrino WLAN/
Combo module), in conjunction with a compatible video adapter (purchased sep-
arately), allows you to display the contents of the notebook display on another dis-
play (e.g. HDTV) without the need to have cables stretching across a room. You can
then play games, browse the internet, display videos or photo slide shows on your
TV/external display without using HDMI or A/V cables.

Before configuring the Intel® WiDi application you will need to set up your com-
patible adapter with your display/speakers. Connect the adapter using an HDMI or
A/V cable and turn on the display (or in the case of speakers connect them to the
wireless speaker adapter with the cables provided with the adapter), and then set the
display to the appropriate input channel (see the documentation supplied with your
compatible adapter for full details).


Compatible 
Adapters

For a list of compatible
display and audio adapt-
ers check the Intel web-
site, or your distributor/
supplier.
7 - 38 Intel® Wireless Display Application



Modules & Options

7

Intel® WiDi Application Installation
1. Insert the Device Drivers & Utilities + User’s Manual disc into the DVD 

drive. 
2. Click Option Drivers (button).
3. Click 6.Install WiDi AP > Yes.
4. Click Next.
5. Click the button to accept the license and click/tap Next.
6. Click Finish.
Intel® Wireless Display Application 7 - 39
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Intel® WiDi Application Configuration
1. Double-click the Intel(R) Wireless Display icon  on the desktop.
2. Click I agree to the terms of this license (button).
3. The application will scan for any connected compatible adapters (or you can click/

tap the Scan for available adapters button to enable Intel My WiFi Technology).

Figure 7 - 32
Intel® WiDi Scan
7 - 40 Intel® Wireless Display Application
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4. Click to select any detected adapters, and click Connect.
5. The system will then prompt you to enter the 4-digit security code which will be 

displayed on the external TV Screen (or press the connect button on the wireless 
speaker adapter).

6. Enter the code for the video adapter and click Continue.

\

Figure 7 - 33
Intel® WiDi Connect 

& Enter Security 
Code
Intel® Wireless Display Application 7 - 41
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7. You will then be prompted to enter a name for the video adapter and click/tap 
Continue.

8. Click Finished to complete the setup.

Figure 7 - 34
Intel® WiDi 
Connected 
7 - 42 Intel® Wireless Display Application
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Chapter 8: Troubleshooting

Overview
Should you have any problems with your computer, before consulting your service representative, you may want
to try to solve the problem yourself. This chapter lists some common problems and their possible solutions. This
can’t anticipate every problem, but you should check here before you panic. If you don’t find the answer in these
pages, make sure you have followed the instructions carefully and observed the safety precautions in the preface.
If all else fails, talk to your service representative. You should also make a record of what happened and what
remedies you tried.

Of course, if something goes wrong, it will happen at the most inconvenient time possible, so you should preview
this section just in case. If, after you’ve tried everything, and the system still won’t cooperate, try turning it off
for a few minutes and then rebooting. You will lose any unsaved data, but it may start working again. Then call
your service representative.
Overview 8 - 1
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Basic Hints and Tips
Many of the following may seem obvious but they are often the solution to a problem when your computer ap-
pears not to be working. 

• Power - Is the computer actually plugged into a working electrical outlet? If plugged into a power strip, 
make sure it is actually working. Check the LED Power & Communication Indicators (see “LED Indica-
tors & Buttons” on page 1 - 9) to see the computer’s power status.

• Connections - Check all the cables to make sure that there are no loose connections anywhere.

• Power Savings - Make sure that the system is not in Hibernate or Sleep mode by pressing the keys config-
ured in your Power Options, or power button, to wake-up the system.

• Brightness - Check the brightness of the screen by pressing the brightness buttons to adjust the brightness.

• Display Choice - Make sure the system is not set to “external only” display if an external display is 
attached.

• Boot Drive - Make sure there are no optical media and/or USB storage devices in any connected drive 
when you start up your machine (this is a common cause of the message “Invalid system disk - Replace the 
disk, and then press any key” / “Remove disks or other media. Press any key to restart”).
8 - 2 Basic Hints and Tips
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Backup and General Maintenance
• Always backup your important data, and keep copies of your OS and programs safe, but close to hand. 

Don’t forget to note the serial numbers if you are storing them out of their original cases, e.g. in a CD wal-
let.

• Run maintenance programs on your hard disk and OS as often as you can. You may schedule these pro-
grams to run at times when you are not using your computer. You can use those that are provided free with 
your OS, or buy the more powerful dedicated programs to do so.

• Write down your passwords and keep them safe (away from your computer). This is especially important if 
you choose to use a Supervisor password for the BIOS (see “Security Menu” on page 5 - 10).

• Keep copies of vital settings files such as network, dialup settings, mail settings etc.(even if just brief notes).


Warranty

The CPU is not a user serviceable part. Accessing the CPU in any way, may violate your warranty.
Backup and General Maintenance 8 - 3
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Viruses
• Install an Anti-Virus program and keep the definitions file (the file which tells your program which viruses 

to look for) up to date. New computer viruses are discovered daily, and some of them may seriously harm 
your computer and cause you to lose data. Anti-Virus programs are commercially available and the defini-
tions file updates are usually downloadable directly from the internet.

• Be careful when opening e-mail from sources you don’t know. Viruses are often triggered from within e-
mail attachments so take care when opening any attached file. You can configure most Anti-Virus pro-
grams to check all e-mail attachments. Note: You should also beware of files from people you know as the 
virus may have infected an address book and been automatically forwarded without the person’s knowl-
edge.

• Keep a “Bootable CD-ROM/DVD-ROM/USB storage device” (this CD/DVD/USB device provides basic 
information which allows you to startup your computer) handy. You may refer to your OS’s documentation 
for instructions on how to make one, and many Anti-Virus programs will also provide such a disk (or at 
least instructions on how to make one).
8 - 4 Viruses
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Upgrading and Adding New Hardware/Software
• Do not be tempted to make changes to your Windows Registry unless you are very sure of what you are 

doing, otherwise you will risk severely damaging your system.

• Don’t open your computer or undertake any repair or upgrade work if you are not comfortable with what 
you are doing.

• Read the documentation. We can assume, since you are reading this that you are looking at the computer’s 
manual, but what about any new peripheral devices you have just purchased? Many problems are caused by 
the installation of new hardware and/or software. Always refer to the documentation of any new hardware 
and/or software, and pay particular attention to files entitled “READ ME” or “READ ME FIRST”.

• When installing a new device always make sure the device is powered on, and in many cases you will need 
to restart the computer. Always check that all the cables are correctly connected.

• Make sure you have installed the drivers for any new hardware you have installed (latest driver files are 
usually available to download from vendor’s websites).
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• Thoroughly check any recent changes you made to your system as these changes may affect one or more 
system components, or software programs. If possible, go back and undo the change you just made and see 
if the problem still occurs.

• Don’t over complicate things. The less you have to deal with then the easier the source of the problem may 
be found; Example - if your computer has many devices plugged into its ports, and a number of programs 
running, then it will be difficult to determine the cause of a problem. Try disconnecting all of the devices and 
restarting the computer with all the peripheral devices unplugged. A process of elimination (adding and 
removing devices and restarting where necessary) will often find the source of a problem, although this may 
be time consuming.
8 - 6 Upgrading and Adding New Hardware/Software
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Problems & Possible Solutions

Problem Possible Cause - Solution

The computer feels too
hot.

Make sure the computer is properly ventilated and the Vent/Fan intakes are not blocked. If this
doesn’t cool it down, put the system into Hibernate mode or turn it off for an hour. Make sure the
computer isn’t sitting on a thermal surface. Make sure you’re using the correct adapter. 

Nothing appears on
screen.

The system is in a power saving mode. Press the power button or any configured sleep/resume
key combination.

The screen controls need to be adjusted. Press the brightness buttons to adjust the settings. If
you’re connected to an external monitor, make sure it’s plugged in and turned on. You should also
check any attached monitor’s own brightness and contrast controls.

The screen saver is activated. Press any key on the keyboard.

You have pressed the Screen Power Toggle Button  to turn the display off. A quick press of
the button will toggle the display on/off (see Table 1 - 2, on page 1 - 9).

No image appears on the
external monitor I have
plugged in and powered
on.

You haven’t installed the video driver and configured it appropriately from the Control Panel.
See for instructions on installing and configuring the video driver.

The sound cannot be
heard or the volume is
very low.

The volume might be set too low. Check the volume control in the Settings menu in the Charms
Bar in Windows 8 (see “Audio Features” on page 2 - 8), check the volume control in the
Volume Control Panel in the Windows 7 taskbar, or use the volume buttons to adjust the setting
(see “Audio Features” on page D - 14).
Problems & Possible Solutions 8 - 7
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The DVD-ROM cannot
be read.

The DVD-ROM is dirty. Clean it with a DVD-ROM cleaner kit.

The Optical Disk Drive
tray will not open when
there is a disc in the tray.

The compact disc is not correctly placed in the tray. Gently try to remove the disc using the eject
hole (see “Loading Discs” on page 2 - 3).

The DVD regional codes
can no longer be
changed.

The code has been changed the maximum 5 times. See “DVD Regional Codes” on page 2 - 5.

You forget the boot
password.

If you forget the password, you may have to discharge the battery of the CMOS. Contact your
service representative for help.

Problem Possible Cause - Solution


Password Warning

If you choose to set a boot password, NEVER forget your password. The consequences of this could be serious. If you cannot
remember your boot password you must contact your vendor and you may lose all of the information on your hard disk.
8 - 8 Problems & Possible Solutions
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The Wireless LAN/
Bluetooth/PC Camera
modules cannot be
configured.

The driver(s) for the module(s) have not been installed. Make sure you have installed the driver
for the appropriate module See the instructions in Chapter 7 “Modules & Options” for the
appropriate module (no driver is required for the PC Camera module in Windows 8) in Windows
8, or  Appendix D.

A file cannot be copied
to/from a connected
Bluetooth device.

The transfer of data between the computer and a Bluetooth enabled device is supported in one
direction only (simultaneous data transfer is not supported). If you are copying a file from
your computer to a Bluetooth enabled device, you will not be able to copy a file from the Bluetooth
enabled device to your computer until the file transfer process from the computer has been
completed

I cannot obtain high
speed Bluetooth data
transfer.

To obtain high speed Bluetooth data transfer take into account the following:

• To achieve high speed transfer speeds, both devices must support high speed data 
transfer (i.e both the computer and the Bluetooth compatible device you are connecting 
to).

• Check your Bluetooth compatible device’s documentation to confirm it supports high 
speed data transfer, and for configuration information.

Problem Possible Cause - Solution
Problems & Possible Solutions 8 - 9
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Appendix A: Interface (Ports & Jacks)

Overview
The following chapter will give a quick description of the interface (ports & jacks) which allow your computer
to communicate with external devices, connect to the internet etc.
Interface (Ports & Jacks) A - 1
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Computer Ports and Jacks

Item Description

Card Reader Port The card reader allows you to use some of the latest digital storage cards. Push the card into the
slot and it will appear as a removable device.

DC-In Jack Plug the supplied AC/DC adapter into this jack to power your computer.

e-SATA Port This e-SATA (external Serial Advanced Technology Attachment) port allows you to plug-in
external Serial ATA hard drives.

Headphone-Out Jack Headphones or speakers may be connected through this jack. Note: Set your system’s volume to
a reduced level before connecting to this jack.

Microphone-In Jack Plug an external microphone in to this jack to record on your computer.

RJ-45 LAN Jack This port supports LAN (Network) functions.
Note: Broadband (e.g. ADSL) modems usually connect to the LAN port.
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RS-232 COM/Serial 
Ports

The RS-232 COM/serial is a communication interface for data transfer, through which information
transfers in or out one bit at a time. These ports can be used to connect the computer to devices
such as terminals and peripherals.

Security Lock Slot To prevent possible theft, a Kensington-type lock can be attached to this slot. Locks can be
purchased at any computer store.

USB 2.0/1.1 Ports

USB 3.0 Port

These USB (Universal Serial Bus) 2.0 compatible ports (USB 2.0 is fully USB 1.1 compliant) are
for low-speed peripherals such as keyboards, mice or scanners, and for high-speed peripherals
such as external HDDs, digital video cameras or high-speed scanners etc. Devices can be
plugged into the computer, and unplugged from the computer, without the need to turn the system
off (if the power rating of your USB device is 500mA or above, make sure you use the power
supply which comes with the device).

The USB 3.0 port is denoted by its blue color; USB 2.0 ports are colored black. USB 3.0 will
transfer data much faster than USB 2.0, and is backwards-compatible with USB 2.0.

Note that the USB 3.0 ports require a driver for Windows 7 (see “USB 3.0 (Win 7 Only)” on
page D - 24) installation (Windows 8 does not require a driver installation) and do not support
wake on USB.

Item Description

3.0
Interface (Ports & Jacks) A - 3
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Appendix B: Intel Video Driver Controls
The basic settings for configuring the LCD are outlined in “Video Features” on
page 1 - 26.

Intel Video Driver Installation
Make sure you install all the drivers in the order indicated in Table 4 - 1, on page 4 - 4.

Video
1. Insert the Device Drivers & Utilities + User’s Manual disc into the DVD 

drive.
2. Click 2.Install VGA Driver > Yes.
3. Click Next > Yes > Next > Next.
4. Click Finish to restart the computer.

Dynamic Video Memory Technology
Intel® DVMT automatically and dynamically allocates as much system memory
(RAM) as needed (up to 1.7GB) to the video system (the video driver must be in-
stalled). DVMT returns whatever memory is no longer needed to the operating sys-
tem.


DVMT Notes

DVMT is not local video
memory.

DVMT is not user-con-
figurable.

DVMT will not function
in MS-DOS. DOS uses
the legacy memory indi-
cated.
Intel Video Driver Installation B - 1
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Intel® Graphics & Media Control Panel
Advanced video configuration options are provided by the Intel® Graphics and
Media Control Panel. To access the control panel see below and overleaf:

1. Click the Intel® Graphics and Media Control Panel icon in the Start screen.

(see over)

Figure B - 1
Start Screen

Intel® G&M Control 

Panel
B - 2 Intel® Graphics & Media Control Panel
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OR
2. Right-click the Desktop and select Graphics Properties from the menu.
OR
3. Click Advanced settings in the Screen Resolution control panel in Windows.
4. Click the Intel(R)... tab and click Graphics Properties (button).
5. Double-click the Intel(R) G&M control panel in the Windows Control Panel. 

Figure B - 2
Intel® G&M 

Control Panel
Intel® Graphics & Media Control Panel B - 3
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You may make changes to any of the graphics properties by clicking the appropriate
menu tab on the left of the menu and adjusting the settings on the right.

Options & Support

Click Options & Sup-
port and select an item
from the sub-menu to
bring up the help and
support topics.

You will need to be con-
nected to the Internet to
access the key resource
links.

Multiple Display 

At least one other dis-
play must be attached in
order to view multiple
display selection op-
tions.

Figure B - 3
Intel® G&M 

Control Panel Tabs
B - 4 Intel® Graphics & Media Control Panel
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Display Devices & Options
Besides the built-in LCD you can also use an external monitor/flat panel display/TV
connected to the external monitor port as your display device. The table below out-
lines the display options.

Intel Display Mode Description

Single Display
One of the connected displays is used as the display 

device

Clone Displays
Both connected displays output the same view and may 

be configured independently

Extended Desktop
Both connected displays are treated as separate devices, 

and act as a virtual desktop


Default Display Mode

The initial default dis-
play mode when first at-
taching an external
display is set to Extend-
ed Desktop Mode.

You can use the Intel(R)
G&M control panel to
adjust this setting.

Subsequent to any re-
start/shutdown or re-
moval of display device,
the system will retain the
last mode set before the
restart/shutdown or re-
moval of display device.

Table B - 1
Display Modes


Attaching Displays

When you first attach an external display you may find that the desktop does not occupy
the full screen area. Use either the display’s auto adjust/configure controls, or the Intel(R)
G&M control panel to configure the full screen display.
Display Devices & Options B - 5
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Attaching Other Displays
If you prefer to use an external display, connect it to the external monitor port.

To Clone Displays:
1. Attach your display to the external monitor port and turn it on.
2. Go to the Intel(R) G&M control panel and click Display > Multiple Displays.
3. Click Operating Mode and select Clone Displays from the menu.
4. Click Apply, and OK to confirm the settings change.
5. You can switch the Primary/Secondary Display from the menu.


Multiple Display 

At least one other dis-
play must be attached in
order to view Multiple
Display selection op-
tions.

General Settings

Click/tap General Set-
tings to access settings
the options for any at-
tached display. 

Figure B - 4
 Display > Multiple 

Displays (Clone)


Default Display Mode

The initial default display mode
when first attaching an external
display is set to Extended Desk-
top Mode.

You can use the Intel(R) G&M
control panel to adjust this setting.

Subsequent to any restart/shut-
down or removal of display de-
vice, the system will retain the last
mode set before the restart/shut-
down or removal of display de-
vice.
B - 6 Attaching Other Displays
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To Enable Extended Desktop:
1. Attach your display to the external monitor port and turn it on.
2. Go to the Intel(R) G&M control panel and click Display > Multiple Displays.
3. Click Operating Mode and select Extended Desktop from the menu. 
4. Click Apply, and OK to confirm the settings change.


 Display Settings 

Extended Desktop 

You can have different
Colors, Screen Area
and Monitor Refresh
Rates for each display
device provided your
monitor can support
them.

You can drag the moni-
tor icons to match the
physical layout of your
displays. Icons and pro-
grams may also be
dragged between the
displays.

Figure B - 5 

Display > Multiple 

Displays (Extended)

Click the appropriate monitor
icon and drag it to match the
physical arrangement you
wish to use (e.g. the second-
ary display may be extended
left/right/above/below the
primary display).

Click General Settings to
make any adjustments re-
quired.
Attaching Other Displays B - 7



Intel Video Driver Controls

B

To Configure Displays from Devices (Charms Bar)
1. Attach your display to the external monitor port and turn it on.
2. Go the Charms Bar and select Devices.
3. Click Second Screen.
4. Click on any one of the options from the menu to select Duplicate, Extend or a

Single display.


Windows Logo Key 

 + P Key 
Combination

You can also use the 
+ P key combination to
quickly access the Sec-
ond Screen menu in
Windows 8.

Figure B - 6
Second Screen 

(Devices)
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Configuring an External Display in Windows 8
You can also use the Screen Resolution control panel in Windows 8 to configure an
external display.

1. Attach your external display to the appropriate port, and turn it on.
2. Go to the Screen resolution control panel (see “Video Features” on page 1 -

19).
3. Click the Detect button.
4. The computer will then detect any attached displays.

Figure B - 7
Screen Resolution 

Multiple Displays
Attaching Other Displays B - 9
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5. You can configure the displays from the Multiple Displays menu.

• Duplicate these displays - Shows an exact copy of the main display desktop on 
the other display(s)

• Extend these displays - Treats both connected displays as separate devices
• Show desktop only on 1/2 - Only one of your displays is used.

Figure B - 8 

Screen Resolution 

Multiple Display 

Options
B - 10 Attaching Other Displays
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Appendix C: Specifications


Latest Specification Information

The specifications listed in this Appendix are correct at the time of going to press. Certain items (particularly processor types/
speeds and CD/DVD device types) may be changed or updated due to the manufacturer's release schedule. Check with your
distributor/supplier for details.
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Processor

Intel® Core i7-3612QM (2.10GHz)
Quad-Core Mobile Processor
6M L3 Cache, 22nm (22 Nanometer), 
DDR3-1600MHz, TDP 35W

Intel® Core i7-3520M (2.9GHz)
Mobile Processor
4M L3 Cache, 22nm (22 Nanometer), 
DDR3-1600MHz, TDP 35W

Intel® Core i5-3360M (2.8GHz)
Mobile Processor
3M L3 Cache, 22nm (22 Nanometer), 
DDR3-1600MHz, TDP 35W

Intel® Core i5-3320M (2.6GHz)
Mobile Processor
3M L3 Cache, 22nm (22 Nanometer), 
DDR3-1600MHz, TDP 35W

Intel® Core i5-3210M (2.5GHz)
Mobile Processor
3M L3 Cache, 22nm (22 Nanometer), 
DDR3-1600MHz, TDP 35W

Intel® Core i5-3110M (2.4GHz)
Mobile Processor
3M L3 Cache, 22nm (22 Nanometer), 
DDR3-1600MHz, TDP 35W

Intel® Core i7-2640M (2.8GHz)
Mobile Processor
4M L3 Cache, 32nm (32 Nanometer), 
DDR3-1333MHz, TDP 35W

Intel® Core i5-2540M (2.6GHz)
Mobile Processor
3M L3 Cache, 32nm (32 Nanometer), 
DDR3-1333MHz, TDP 35W

Intel® Core i5-2520M (2.5GHz)
Mobile Processor
3M L3 Cache, 32nm (32 Nanometer), 
DDR3-1333MHz, TDP 35W

Intel® Core i5-2450M (2.5GHz)
Mobile Processor
3M L3 Cache, 32nm (32 Nanometer), 
DDR3-1333MHz, TDP 35W

Intel® Core i5-2430M (2.4GHz)
Mobile Processor
3M L3 Cache, 32nm (32 Nanometer), 
DDR3-1333MHz, TDP 35W

Processor

Intel® Core i3-2370M (2.4GHz)
Mobile Processor
3M L3 Cache, 32nm (32 Nanometer), 
DDR3-1333MHz, TDP 35W

Intel® Core i3-2350M (2.3GHz)
Mobile Processor
3M L3 Cache, 32nm (32 Nanometer), 
DDR3-1333MHz, TDP 35W

Intel® Pentium® B980 (2.3GHz)
2M L3 Cache, 32nm (32 Nanometer), 
DDR3-1333MHz, TDP 35W

Intel® Pentium® B970 (2.3GHz)
2M L3 Cache, 32nm (32 Nanometer), 
DDR3-1333MHz, TDP 35W

Intel® Pentium® B960 (2.2GHz)
2M L3 Cache, 32nm (32 Nanometer), 
DDR3-1333MHz, TDP 35W

Intel® Pentium® B950 (2.1GHz)
2M L3 Cache, 32nm (32 Nanometer), 
DDR3-1333MHz, TDP 35W
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Core Logic

Mobile Intel® HM76 Express Chipset

Display

19"(48.26cm) WXGA+ (1440 * 900) 16:10 
Panel
Adjustable Screen Height
Hard Glass (Factory Option - Model A)
Multi Touch Screen (Resistive Type for 
Windows 7 Only - Model B)

Memory

Dual Channel DDRIII (DDR3)

Two 204 Pin SO-DIMM Sockets 
Supporting DDRIII (DDR3) 1333MHz/
1600MHz Memory Modules

Memory Expandable up to 16GB
Compatible with 2GB/4GB/8GB Modules 

Video Adapter

Intel® Integrated GPU (Intel® HD 
Graphics / Intel® HD Graphics 3000 / 
Intel® HD Graphics 4000):
Dynamic Frequency
Intel® DVMT Shared Memory Architecture 
up to 1748MB

Microsoft DirectX®10 Compatible (Intel® 
HD Graphics / Intel® HD Graphics 3000)

Microsoft DirectX®11 Compatible (Intel® 
HD Graphics 4000)

BIOS

One 48Mb SPI Flash ROM
AMI™ BIOS

Storage

Two Changeable 2.5", 9.5 mm (h) SATA 
(Serial) Hard Disk Drives

One 12.7 mm Super Multi/Blu-ray Combo 
SATA Optical Device Drive (Factory 
Option)

Audio

High Definition Audio
Built-In Microphone
2 Built-In Speakers

Interface

Two USB 2.0 Ports
Three USB 3.0 Ports
One eSATA Port
One External VGA Port
One Headphone-Out Jack
One Microphone-In Jack
One RJ-45 LAN Jack
2 * RS232 Serial COM Ports
One DC-in Jack
Specifications C - 3



Specifications

C

Card Reader

Embedded Multi-In-1 Card Reader 
- MMC/ RS MMC
- SD/ Mini SD / SDHC/ SDXC
- MS/ MS Pro/ MS Duo

Note: Some of these cards require PC 
adapters that are usually supplied with 
the cards.

Slots

ExpressCard/34/54 Slot

Two Mini Card Slots
Slot 1 for Half Size WLAN Combo 
Module with PCIe and USB Interface

Slot 2 for mSATA SSD Full Size with 
SATA Interface

Communication

Built-In 10/100/1000 Mb Base-TX Ethernet 
LAN

Intel® Centrino® Wireless-N 2230 2*2 
(802.11 b/g/n) Half Mini-Card PCIe WLAN + 
Bluetooth V4.0+HS Combo Module 
(Factory Option)

Intel® Centrino® Wireless-N 135 1*1
(802.11 b/g/n) Half Mini-Card PCIe WLAN +
Bluetooth Combo Module (Factory Option)

802.11b/g/n WLAN Half Mini-Card 
Module (Factory Option)

Combo WLAN (802.11b/g/n) and 
Bluetooth v4.0 LE Half Mini-Card Module 
(Factory Option)

2.0M HD PC Video Camera Module

Power Management

Supports Wake on LAN
Supports Wake on USB
Supports Wake RTC Alarm

Power

Full Range AC/DC Adapter – AC in 100 - 
240V, 50 - 60Hz DC Output 19V, 4.74A 
(90 Watts)

Security

Security (Kensington® Type) Lock Slot
BIOS Password

Operating System

Model A:
Windows® 8 or Windows® 7 with 
Service Pack 1
Model B:
Windows® 7 with Service Pack 1

Design Features

Textured Finish
Supports Intel® Rapid Start Technology
Supports Intel® Anti-Theft Technology
Supports Intel® Smart Connect 
Technology
VESA MIS-D 100 (100mm * 100mm)
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LED Indicators

Power / Suspend, HDD/ODD, PC Camera

Environmental Spec

Temperature
Operating: 5°C - 35°C
Non-Operating: -20°C - 60°C
Relative Humidity
Operating: 20% - 80%
Non-Operating: 10% - 90%

Physical Dimensions & Weight

450mm (w) * 312mm (d) * 53.5 - 151mm (h)

Model A:
6.7Kg with ODD
7.1Kg with ODD and Hard Glass Screen

Model B:
7.3Kg with ODD
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Appendix D: Windows 7

Overview
This Appendix contains information (including control panel information, driver installation etc.) for users
of the Windows 7 OS. 

You can refer to the main manual for details of hardware, BIOS, modules etc. However any information specific
to Windows 7 will be included in this Appendix, as well as details on how to access the applications and control
panels etc.


Windows 7/8 OS

In order to run Windows 7 or 8 (32 Bit) without limitations or decreased performance, your computer requires a minimum
1GB of system memory (RAM), however if you are running Windows 7 or 8 (64 bit) your computer requires a minimum
2GB of system memory (RAM).
Overview D - 1
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Turning On the Computer
Now you are ready to begin using your computer. To turn it on simply press the pow-
er button on the front panel.

When the computer is on, you can use the power button as a Stand by/Hibernate/
Shutdown hot-key button when it is pressed for less than 4 seconds (pressing and
holding the power button for longer than this will shut the computer down). Use
Power Options in the Windows control panel to configure this feature.


Forced Off

If the system “hangs”,
and the Ctrl + Alt + Del
key combination doesn’t
work, press the power
button for 4 seconds, or
longer, to force the sys-
tem to turn itself off.

Power Button as 
Stand by or 

Hibernate Button

You can use the OS’s
“Power Options” control
panel to set the power
button to send the sys-
tem into Stand by or Hi-
bernate mode (see your
OS’s documentation, or
“Configuring the Pow-
er Buttons” on page 3
- 8 for details).


Shut Down

Note that you should always shut your computer down by choosing the Shut Down com-
mand from the bottom right of the Start menu in Windows. This will help prevent hard disk
or system problems.
D - 2 Turning On the Computer
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LED Indicators & Buttons
The LED indicators on the computer display helpful
information about the current status of the computer.

Table D - 1 - LED Indicators

The buttons located under the front panel icons allow
you to make screen and input adjustments.

Figure D - 1 - Front Icons

Table D - 2 - Function Buttons

Icon Color Description

Green The computer is On

Blinking Green The computer is in Sleep Mode

Orange
The AC/DC Adapter is Plugged in 
& the Computer is Powered Off

Green System Activity

Icon Description

Decrease/Increase Buttons - Use the buttons 
to decrease/increase the brightness/volume

Function Menu Toggle - Use this button to 
display the On Screen Display (see “On 
Screen Display Indicators/Buttons” on 

page D - 4)

Screen Power Toggle - Use this button to 
toggle the LCD on/off
LED Indicators & Buttons D - 3
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On Screen Display Indicators/Buttons
Press the function menu button for about two seconds  to bring up the On Screen Display. The OSD provides
visual indicators for brightness, volume, camera power toggle and WLAN/Bluetooth power toggle (the camera,
WLAN and Bluetooth power indicators will only display if the modules are included in your purchase configu-
ration) when the OSD driver is installed (see page “On Screen Display” on page D - 24).

Table D - 3 - On Screen Display Indicators

The indicators will appear when the computer boots up, or resumes from a power saving state, in order to display
the current power status of the camera and/or Bluetooth/WLAN modules. The OSD indicators will appear if you
adjust the brightness or volume, and will also allow you to adjust the power status of the camera and/or Blue-
tooth/WLAN modules by using the mouse to click on the icon (note that this system does not display the Win-
dows Mobility Center). If your purchase configuration includes the Multi-Touch Panel you may use a finger to
slide along the bars under the on-screen symbols to adjust the volume and brightness and controls, or to press
the on/off buttons to toggle power to the camera and/or Bluetooth/WLAN modules.

OSD Icon Description OSD Icon Description

Volume Decrease/Increase Camera Power Toggle

Brightness Decrease/Increase Bluetooth Power Toggle

WLAN Power Toggle
D - 4 On Screen Display Indicators/Buttons
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Windows 7 Start Menu & Control Panel
Most of the control panels, utilities and programs within Windows 7 are accessed from the Start menu. When
you install programs and utilities they will be installed on your hard disk drive, and a shortcut will usually be
placed in the Start menu and/or the desktop. Right-click the Start menu icon , and then select Properties to
customize the appearance of the Start menu.

In many instances throughout this manual you will see an instruction to open the Control Panel. The Control
Panel is accessed from the Start menu, and it allows you to configure the settings for most of the key features
in Windows (e.g. power, video, network, audio etc.). Windows 7 provides basic controls for many of the features,
however many new controls are added (or existing ones are enhanced) when you install the drivers. To see all
controls it may be necessary to toggle off Category View to view the control panel icons.

Figure D - 2 - Start Menu & Control Panel

Click here to toggle Category View

 

Windows 7 Start Menu & Control Panel D - 5
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Video Features
You can configure display options from the Display (Control Panel) and Screen Resolution in Windows 7.
For more detailed video information see Appendix B.

To access Display (Control Panel) and Screen Resolution in Windows:
1. Click Start and click Control Panel.
2. Click Display (icon) - In the Appearance and Personalization category.
3. Click Adjust Screen Resolution/Adjust resolution.

Figure D - 3 - Screen Resolution
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Right-Click Desktop

1. You can right-click the 
desktop and select 
Screen resolution  
(Figure D - 3).

2. Use the dropbox to select 
the screen Resolution 

 (Figure D - 3).
3. Click Advanced settings 

 (Figure D - 3) to bring 
up the Advanced 
properties tabs.

1

2

3
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To access the Intel(R) Graphics Media Accelerator Driver for mobile control panel:
1. Click Advanced settings  (Figure D - 3 on page D - 6) in the Screen Resolution control panel in Win-

dows.
2. Click the Intel(R)... tab and click Graphics Properties (button)  (Figure D - 4 on page D - 7) .
OR
3. Right-click (tap, hold and release) and select Graphics Properties from the menu.
OR
4. Click the icon  in the taskbar and select Graphics Properties from the menu.

Figure D - 4 - Intel GMA Driver for Mobile Control Panel
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4
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Video Features D - 7
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Configuring an External Display in Windows 7
You can also use the Screen Resolution control panel in Windows 7 to configure an external display.

1. Attach your display to the external monitor port and turn it on.
2. Go to the Screen resolution control panel (see “Video Features” on page D - 6).
3. Click the Detect button.
4. The computer will then detect any attached displays.

Figure D - 5 - Screen Resolution Multiple Displays (Win 7)
D - 8 Configuring an External Display in Windows 7
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5. You can configure the displays from the Multiple Displays menu.

Figure D - 6 - Screen Resolution Multiple Display Options (Win 7)

• Duplicate these displays - Shows an exact copy of the main display desktop on the other display(s).
• Extend these displays - Treats both connected displays as separate devices.
• Show desktop only on 1/2 - Only one of your displays is used.
Configuring an External Display in Windows 7 D - 9
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Using the Windows Logo Key  + P Key Combination to Switch Displays
You can also use the  + P key combination to quickly change display configuration and modes (this is partic-
ularly useful when attaching a projector) in Windows 7.

1. Attach your display to the external monitor port and turn it on.
2. Press the  + P key combination.
3. An on-screen menu will pop up.
4. Use the cursor keys (or  + P) to select the appropriate configuration from the menu, and press Enter to

confirm the selection.

Figure D - 7  + P Display Configuration Selection (Win 7)
D - 10 Configuring an External Display in Windows 7
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Power Options
The Power Options (Hardware and Sound menu) control panel icon in Windows allows you to configure pow-
er management features for your computer. You can conserve power by means of power plans and configure
the options for the power button, sleep button, display and sleep mode from the left menu. Note that the power
saver plan may have an affect on computer performance.

Click to select one of the existing plans, or click Create a power plan in the left menu and select the options to
create a new plan. Click Change plan settings and click Change advanced power settings to access further con-
figuration options.

Figure D - 8 - Power Options
Power Options D - 11
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Power Plans
The computer can be configured to conserve power by means of power plans. You
can use (or modify) an existing power plan, or create a new one.

The settings may be adjusted to set the display to turn off after a specified time, and
to send the computer into Sleep after a period of inactivity. 

Click Change plan settings and then click Change advanced power settings to ac-
cess further configuration options in Advanced Settings.



Password

It is recommended that
you enable a password
on system resume in or-
der to protect your data.

Figure D - 9
Power Plan 

Advanced Settings
D - 12 Power Options
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Adding Hibernate Shut Down Menu in Windows 7
Hibernate mode will not appear in the Shut Down menu by default. If you want to
add Hibernate mode to the Shut Down menu do so as follows.

1. Go to the Power Options (Hardware and Sound) control panel.
2. Click Change plan settings for the currently active power plan.
3. Click Change advanced power settings.
4. Click Sleep.
5. Click the plus sign next to Allow hybrid sleep.
6. Change the setting to Off.
7. Click Apply and close the control panel.
8. Hibernate should now appear in the menu.

Figure D - 10
Adding Hibernate to 
Shut Down (Win 7)
Power Options D - 13
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Audio Features
You can configure the audio options on your computer from the Sound  control
panel in Windows, or from the Realtek HD Audio Manager  icon in the notifica-
tion area/control panel (right-click the taskbar notification area icon  to bring up an
audio menu). The volume may also be adjusted by means of the volume icon in the
taskbar or the On Screen Display Indicators (see Table D - 3, on page D - 4). 


Volume Adjustment

The sound volume level
is set using the volume
control within Windows
(and the volume func-
tion keys on the comput-
er). Click the volume
icon in the notification
area to check the set-
ting.

Figure D - 11
Realtek Audio 

Manager

Right-click the icon 
to access the menu 
above.

Note that many keyboards have built-in controls to allow you to adjust the audio vol-
ume.
D - 14 Audio Features
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Setup for Audio Recording
To record audio sources on your computer at optimum quality follow the instructions below:

1. Click Start, and click Control Panel (or point to Settings and click Control Panel) and make sure you are in 
Classic View.

2. Click Realtek HD Audio Manager (or right-click the taskbar icon  and select Sound Manager).
3. Click Microphone Effects (tab) in Microphone (tab), and then click to select Noise Suppression (button), or 

adjust the Recording Volume level to around 60, to obtain the optimum recording quality.
4. Click OK to close the control panel and save the settings.

Figure D - 12 - Realtek Audio Manager - Recording Setup
Audio Features D - 15
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Tablet PC Input Options for Touch Screen
Tablet PC settings (for touch screen input) may be customized from the Tablet PC Settings in Windows 7. 

1. To access the control panel click Start, and then click Control Panel. 
2. The Tablet PC Settings and Pen and Touch control panel are in the Hardware and Sound category.

Figure D - 13 - Pen and Touch & Tablet PC Settings Control Panels
D - 16 Tablet PC Input Options for Touch Screen
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3. Click Tablet PC Settings and click Other.
4. Click Go to Input Panel Settings (in Tablet PC Input Panel Options) to configure where and how the Tablet 

PC Input Panel appears.

Figure D - 14 - Input Panel Settings
Tablet PC Input Options for Touch Screen D - 17
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5. Click Go to Pen and Touch (in Tablet PC Input Panel Options) to configure the Pen Options, flicks and 
handwriting etc.

Figure D - 15 - Pen and Touch Settings

6. When not in use the Tablet PC Input Panel docks at the side of the screen (and may be docked at either side 
of the screen at any height) with just a small portion visible.

Figure D - 16 - Tablet PC Input Panel
D - 18 Tablet PC Input Options for Touch Screen
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7. Move the pen over the TIC and then tap it to activate it. The input panel allows you to input text without the use 
of a keyboard.

8. You can use the writing pad (write continuously), character pad (write one character at a time) or touch 
keyboard to input text. 

9. Use Help topics from the Tools menu for further information.

Figure D - 17 - Touch Keyboard, Writing Pad & Help Topics
Tablet PC Input Options for Touch Screen D - 19
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Driver Installation
Insert the Device Drivers & Utilities + User’s Manual
disc into the DVD drive and click Install Drivers/Op-
tion Drivers (button).

Follow the instructions to install the driver. Alterna-
tively click Start, navigate (Browse..) to the execut-
able file and then follow the manual setup instructions.

Figure D - 18 - Drivers Installer Screen 1

1. Check the driver installation order from Table D - 4, 
on page D - 21 (the drivers must be installed in 
this order) which is the same as that listed in the 
Drivers Installer menu below.

2. Click to select the driver you wish to install, (you 
should note down the drivers as you install them).

3. Follow the instructions for each individual driver 
installation procedure as listed on the following 
pages.

Note: If you need to reinstall any driver, you should uninstall the

driver first.

Figure D - 19 - Drivers Installer Screen 2
D - 20 Driver Installation
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Table D - 4 - Driver Installation

Note that you need to install both the WLAN & Bluetooth drivers for the WLAN & Bluetooth Combo modules.

All drivers provided are for Windows 7 with Service Pack 1 or Windows 8.

Win 7 SP1/Win 8 Driver Page # Win 7 SP1/Win 8 Driver Page #

 Chipset Page D - 24
 PC Camera Module (Windows 7)
(Not required for Windows 8)

Page D - 27

 Video Page D - 24  Wireless LAN Module (Windows 7) Page D - 35

 LAN Page D - 24  Bluetooth & WLAN Combo Module (Windows 7) Page D - 54

 ExpressCard/Card Reader Page D - 24  Intel® Rapid Storage Technology Page D - 65

 On Screen Display Page D - 24  Intel® Rapid Start Technology Driver Page D - 66

 USB 3.0 (Win 7 Only)
(Not required for Windows 8)

Page D - 24  Intel® Smart Connect Technology Page D - 74

 MEI Driver Page D - 24  Intel® Wireless Display Application (Windows 7) Page D - 79

 Audio Page D - 25
Driver Installation D - 21
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Manual Driver Installation
Click Browse CD/DVD (button) in the Drivers Install-
er application and browse to the executable file in the
appropriate driver folder.

Windows Update
After installing all the drivers make sure you enable
Windows Update in order to get all the latest security
updates etc. (all updates will include the latest hotfixes
from Microsoft). See “Windows 7 Update” on page D
- 25 for instructions.

Updating/Reinstalling Individual Drivers
If you wish to update/reinstall individual drivers it
may be necessary to uninstall the original driver.To do
this go to the Control Panel in the Windows OS and
double-click the Programs and Features icon (Pro-
grams > Uninstall a program). Click to select the
driver (if it is not listed see below) and click Uninstall,
and then follow the on screen prompts (it may be nec-
essary to restart the computer). Reinstall the driver as
outlined in this chapter.

If the driver is not listed in the Programs and Fea-
tures menu:

1. Click Start, and click Control Panel (or point to 
Settings and click Control Panel).

2. Double-click Device Manager (Hardware and 
Sound > Device Manager).

3. Double-click the device you wish to update/reinstall 
the driver for (you may need to click “+” to expand 
the selection).

4. Click Driver (tab) and click the Update Driver or 
Uninstall button and follow the on screen prompts.
D - 22 Driver Installation
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User Account Control
If a User Account Control prompt appears as part of
the driver installation procedure, click Continue or
Allow, and follow the installation procedure as direct-
ed.

Windows Security Message
If you receive a Windows security message as part of
the driver installation process. Just click “Install this
driver software anyway” or “Install” to continue the
installation procedure.

You will receive this message in cases where the driv-
er has been released after the version of Windows you
are currently using. All the drivers provided will have
already received certification for Windows.

New Hardware Found
If you see the message “New Hardware Found” dur-
ing the installation procedure (other than when out-
lined in the driver install procedure), click Cancel
to close the window, and follow the installation proce-
dure.


Driver Installation General Guidelines

The driver installation procedure outlined in this Chapter
(and in Chapter 7 Options & Modules), are accurate at
the time of going to press.

Drivers are always subject to upgrade and revision so
the exact procedure for certain drivers may differ slight-
ly. As a general guide follow the default on screen in-
structions for each driver (e.g. Next > Next > Finish)
unless you are an advanced user. In many cases a re-
start is required to install the driver.
Driver Installation D - 23
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Driver Installation Procedure
Insert the Device Drivers & Utilities + User’s Manual
disc into your DVD drive and click Install Drivers
(button).

Chipset
1. Click 1.Install Chipset Driver > Yes.
2. Click Next > Yes > Next > Next.
3. Click Finish to restart the computer.

Video
1. Click 2.Install VGA Driver > Yes.
2. Click Next > Yes > Next > Next.
3. Click Finish to restart the computer.

LAN
1. Click 3.Install LAN Driver > Yes. 
2. Click Next > Install > Finish.
3. The network settings can now be configured.

ExpressCard/Card Reader
1. Click 4.Install Cardreader Driver > Yes.
2. Click Finish.

On Screen Display
1. Click 5.Install OSD Driver > Yes.
2. Click Next > Next.
3. Click Finish > Finish to restart the computer.

USB 3.0 (Win 7 Only)
1. Click 6.Install USB 3.0 Driver > Yes. 
2. Click Next > Yes > Next > Next.
3. Click Finish to restart the computer.

MEI Driver
1. Click 7.Install MEI Driver > Yes.
2. Click Next > Yes > Next.
3. Click Finish to restart the computer.
D - 24 Driver Installation
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Audio
1. Click 8.Install Audio Driver > Yes. 
2. Click Next.
3. Click Finish to restart the computer.

Note that after installing the audio driver the system
will not return to the Drivers Installer screen. To in-
stall any of the optional drivers listed overleaf, eject
the Device Drivers & Utilities + User’s Manual disc
and then reinsert it (or double-click the disc icon in My
Computer), and click Option Drivers (button) to ac-
cess the optional driver menu.

Windows Experience Index
After the drivers are installed follow this procedure to
ensure an accurate rating from the Windows Experi-
ence Index:

1. Click Start, and click Control Panel.
2. Click Performance Information and Tools 

(System and Security > System > Check the 
Windows Experience Index).

3. Click “Rate this computer”.
4. The computer will take a few minutes to assess 

the system performance.
5. Close the control panel.


Windows 7 Update

After installing all the drivers make sure you enable Win-
dows Update in order to get all the latest security up-
dates etc., (all updates will include the latest hotfixes
from Microsoft).

To enable Windows Update make sure you are con-
nected to the internet:

1. Click Start, and click Control Panel (or point to 
Settings and click Control Panel).

2. Click Windows Update (System and Security).
3. Click Check for updates (button).
4. The computer will now check for updates (you 

need to be connected to the internet).
5. Click Install now (button) to begin checking for the 

updates.
6. Click Install updates (button) to install the 

updates.
Driver Installation D - 25
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Optional Drivers
See the pages indicated in Table D - 4, on page D - 21 for the driver installation procedures for any modules
included in your purchase option. Insert the Device Drivers & Utilities + User’s Manual disc and click Option
Drivers (button) to access the optional driver menu.

Figure D - 20 - Optional Drivers
D - 26 Driver Installation
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PC Camera Module (Windows 7)
Before installing the Windows 7 PC Camera driver, make sure the PC Camera is on. Use the On Screen Display
button (see page D - 4) to toggle power to the PC Camera module. When the PC Camera application is run the
LED indicator to the left of the camera will be illuminated in red (see  Figure 1 - 2 on page 1 - 6).

Install the camera driver as indicated overleaf and install all the drivers in the order indicated in Table D - 4, on
page D - 21. Make sure you access the camera application via the desktop shortcut.

2


PC Camera Application and Power-Saving States

If the computer enters Sleep or Hibernate mode while running the camera application, the
program will stop running, and will need to be restarted when the system resumes from the
power-saving state.

Latest PC Camera Driver Information

Check the Device Drivers & Utilities + User’s Manual disc and any accompanying insert
pages, for the latest updated information on the PC Camera driver, which may override the
information provided here.
PC Camera Module (Windows 7) D - 27
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PC Camera Driver Installation
1. Insert the Device Drivers & Utilities + User’s Manual disc into the DVD drive.
2. Make sure the camera module is on before beginning the installation process (use the On Screen Display to 

toggle power to the camera module - see page D - 4).
3. Click Option Drivers (button).
4. Click 1.Install Webcam Driver > Yes.
5. Click Finish to restart the computer.

OR
Click Next > Finish.

6. Run the camera application program from the desktop shortcut (if the hardware is turned off use the On 
Screen Display button to turn it on again). 
D - 28 PC Camera Module (Windows 7)



Windows 7

W
in

d
o

w
s 7
PC Camera Audio Setup
If you wish to capture video & audio with your camera, it is necessary to setup the audio recording options in
Windows.

1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Click Sound  (Hardware and Sound).
3. Click Recording (tab).
4. Right-click Microphone (Realtek High Definition Audio) and make sure the item is not disabled.
5. Double-click Microphone (or select Properties from the right-click menu).
6. Click Levels (tab), and adjust the Microphone and Microphone Boost sliders to the level required.
7. Click OK and close the control panels.
8. Run the camera application program from the desktop shortcut.
9. Go to the Devices menu heading and select Microphone (Realtek....) (it should have a tick alongside it).
10. Go to the Capture menu heading and select Capture Audio (it should have a tick alongside it).
11. To obtain the best sound recording quality enable Noise Suppression in the Realtek HD Audio Manager 

control panel (see “Setup for Audio Recording” on page D - 15).
PC Camera Module (Windows 7) D - 29
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Figure D - 21 - Audio Setup for PC Camera

Right-click
D - 30 PC Camera Module (Windows 7)
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Camera Application
The camera application is a video viewer for general purpose video viewing and testing, and for capturing video
files to .avi format.

1. Run the camera application from the desktop shortcut (it is recommended that you set the capture file before 
the capture process - see below).

2. Go to the Capture menu heading (if you wish to capture audio check “PC Camera Audio Setup” on page D - 
29) and select Start Capture.

3. Click OK/Yes (the file location will be displayed in the pop-up box) to start capturing the video, and press Esc to 
stop the capture (you can view the file using the Windows Media Player).

Set Capture File
Prior to capturing video files you may select the Set Capture File... option in the File menu, and set the file
name and location before capture (this will help avoid accidentally overwriting files). Set the name and location
then click Open, then set the "Capture file size:" and click OK. You can then start the capture process as on
the previous page.

Note the important information in “Reducing Video File Size” on page D - 32 in order to save file space,
and help prevent system problems.
PC Camera Module (Windows 7) D - 31
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Reducing Video File Size
Note that capturing high resolution video files requires a substantial amount of disk space for each file. After
recording video, check the video file size (right-click the file and select Properties) and the remaining free space
on your hard disk (go to My Computer, right-click the hard disk, and select Properties). If necessary you can
remove the recorded video file to a removable medium e.g. CD, DVD or USB Flash drive.

Note that the Windows system requires a minimum of 15GB of free space on the C: drive system partition. In
order to prevent system problems it is recommended that you save the captured video file to a location other than
the C: drive (see “Set Capture File” on page D - 31), limit the file size of the captured video or reduce video
resolution (see below).

To Reduce Video Resolution Output Size:

1. Run the camera application program from the desktop shortcut.
2. Go to Options and scroll down to select Video Capture Pin....
3. Click the Output Size drop box and select a lower resolution size in order to reduce the captured file size.
4. Click OK.
D - 32 PC Camera Module (Windows 7)
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Eliminating Screen Flicker
If you find that the video screen in the camera program is flickering, you can try to
adjust the setting in the Video Capture Filter options.

1. Run the camera application from the desktop shortcut.
2. Go to Options and scroll down to select Video Capture Filter....
3. Click either 50Hz or 60Hz under Powerline Frequency (Anti Flicker).

Figure D - 22 - Video Capture Filter


Latest PC Camera 
Driver Information

Check the Device Driv-
ers & Utilities + User’s
Manual disc, and any
accompanying insert
pages, for the latest up-
dated information on the
PC Camera driver,
which may override the
information provided
here, including the fig-
ures pictured here.
PC Camera Module (Windows 7) D - 33
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Taking Still Pictures
The camera application allows you to take still pictures.

1. Run the camera application from the desktop shortcut.
2. Go to Options and select Take Picture.
3. The picture (in JPEG format) will be placed in the Snapshot folder  on the 

desktop.


Snapshot Folder

The Snapshot folder’s
default location is on the
desktop. Do not move
this folder or an error
may appear when you
try to take a still picture.

If you accidentally de-
lete or move the folder,
you can create a new
Snapshot folder on the
desktop in order to cap-
ture the files.
D - 34 PC Camera Module (Windows 7)
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Wireless LAN Module (Windows 7)
If you have included an Intel® or 3rd Party module in your purchase option use the On Screen Display button
(see page D - 4) to toggle power to the Wireless LAN module, and make sure that the module is on before install-
ing the driver. See “Wireless LAN Module (Windows 8)” on page 7 - 8 for Windows 8 configuration informa-
tion.

Make sure you install the drivers in the order indicated in Table D - 4, on page D - 21.

Note that you need to install both the WLAN & Bluetooth drivers for the WLAN & Bluetooth Combo modules.
Wireless LAN Module (Windows 7) D - 35
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3rd Party 802.11b/g/n Driver Installation
If you see the message “Found New Hardware” click Cancel to close the window.

1. Make sure the module is powered on, and then insert the Device Drivers & Utilities + User’s Man-
ual disc into the DVD drive. 

2. Click Option Drivers (button).
3. Click 2.Install WLAN Driver > Yes.
4. Choose the language you prefer and click Next.
5. Click Finish to restart the computer.

Note: The operating system is the default setting for Wireless LAN control in Windows (see page D - 40). See
“Wireless LAN Module (Windows 8)” on page 7 - 8 for Windows 8 configuration information.
D - 36 Wireless LAN Module (Windows 7)
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Intel® WLAN Driver Installation
For a standard Intel® WLAN driver installation and configuration choose the Typical Installation below and
use the Windows OS for Wireless LAN control (see overleaf). If you want to use Intel® PROSet/Wireless
WiFi Connection Utility as your WLAN interface, and/or add Intel® MyWifi Technology (Personal Area Net-
work) see overleaf.

Typical Installation:
1. If you see the message “Found New Hardware” click Cancel to close the window.
2. Make sure the module is powered on, and then insert the Device Drivers & Utilities + User’s Man-

ual disc into the CD/DVD drive. 
3. Click Option Drivers (button).
4. Click 2.Install WLAN Driver > Yes.
5. Click Next > Next.
6. Click the button to accept the license and click Next.
7. Click Typical > Install.
8. Click Finish.

Note: The operating system is the default setting for Wireless LAN control in Windows (see page D - 40). See
“Wireless LAN Module (Windows 8)” on page 7 - 8 for Windows 8 configuration information.
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Custom Installation (for Intel® PROSet/Wireless WiFi Connection Utility):
1. If you see the message “Found New Hardware” click Cancel to close the 

window.
2. Make sure the module is powered on, and then insert the Device Drivers & 

Utilities + User’s Manual disc into the DVD drive. 
3. Click Option Drivers (button).
4. Click 2.Install WLAN Driver > Yes.
5. Click Next > Next.
6. Click the button to accept the license and click Next > Custom.
7. To install Intel® PROSet/Wireless WiFi Connection Utility click the + icon 

(if necessary) to display the items below it (Administrator Toolkit and Intel® 
PROSet/Wireless Enterprise Software). Click the icon  alongside the 
Administrator Toolkit and Intel® PROSet/Wireless Enterprise Software and 
select “Entire feature will be installed on local hard drive” (see Figure D - 
23 on page D - 39).

8. Click Next > Install > Finish.
9. See “Connecting to a Wireless Network Using Intel® PROSet Wireless” on 

page D - 43 for further information.


Intel® My WiFi

If you want to install In-
tel® My WiFi Technol-
ogy (Intel® MWT) to
transform your system
into a Wi-Fi Personal
Area Network see “In-
tel® My WiFi Configu-
ration” on page 8 - 23.
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Figure D - 23
Install Intel® 

PROSet/Wireless 
WiFi Connection 

Utility
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Connecting to a Wireless Network in Windows 7
Make sure the Wireless LAN module is turned on.

1. Click the taskbar wireless icon , and then double-click an access point to connect to or click to Open Net-
work and Sharing Center if you do not see a network you want to connect to in the taskbar menu (a list of 
options will appear allowing setting changes, and creating a new network).

Figure D - 24 - Click Taskbar Icon Menu & Network and Sharing Center


Network and 

Sharing Center

You can also use the Net-
work and Sharing Cen-
ter control panel in
Windows (Network and
Internet) to connect to
any available wireless
networks.
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2. You may need to enter a security key for any access point to which you are trying to connect.
3. Click to select a network location (e.g. Home, Work or Public).
4. Click “View or change settings in Network and Sharing Center” to access further options for the connection.

Figure D - 25 - Network Location Set
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5. Click the taskbar icon  to see any currently connected networks.
6. To disconnect from the wireless network you can click the taskbar wireless icon , click the active connection 

and then click Disconnect (button).

Figure D - 26 - Click Taskbar Icon Menu - Disconnect


Security Enabled 

Networks

You should try to make
sure that any network
you are connecting to is
a secure network.

Connecting to unsecure
networks may allow un-
authorized access to
your computer, docu-
ments, websites and
files etc.
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Connecting to a Wireless Network Using Intel® PROSet Wireless
(For Intel® WLAN Modules Only) 
1. Make sure the Wireless LAN module is on.
2. Access the Intel® WiFi Connection Utility from the Start menu (Start > All Programs > Intel PROSet 

Wireless > WiFi Connection Utility).
3. Click to select a network from the found list WiFi network access points, or click Refresh to update the list.

Figure D - 27 - Intel® PROSet/Wireless WiFi Connection Utility (Connect)
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4. Click Connect to connect to the select WiFi network access point.
5. If the access point is encrypted then you will need to enter the password and click OK.

Figure D - 28 - Intel® PROSet/Wireless WiFi Connection Utility (Connecting & Connected)

6. You can turn WiFi On/WiFi Off from the button at the bottom of the Utility.
7. To disconnect, select the connected access point and click Disconnect.
8. Select Help from the menu at the top of the utility (or at the bottom right) to bring up the Help menu. 
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Installing Intel® MyWiFi Technology (for Intel® WLAN Modules Only)
If you want to install Intel® MyWifi Technology (Personal Area Network) then follow the procedure outlined
here. Note that if you wish to install Intel® MyWiFi you will need to install Microsoft.net Framework 4.0 (or
later version) before installing the driver as per the procedure below. To get the Microsoft.net Framework
file go to the Microsoft website, search for the file, download it and then install it.

1. Make sure the WLAN module is powered on, and then insert the Device Drivers & Utilities + 
User’s Manual disc into the CD/DVD drive.

2. Insert the Device Drivers & Utilities + User’s Manual disc into the CD/DVD drive.
3. Click Browse and browse to the driver location (X: denotes your DVD drive):
• X:\Options\02_WLAN\Intel_Combo\My_WiFi_Dashboard\Autorun.exe

4. Click Next > Next.
5. Click the button to accept the license and click Next > Next > Install.
6. Click Finish.
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Intel® My WiFi Configuration
You can configure the My WiFi settings as follows.

1.Make sure the Wireless LAN module is on.
2.Access the Intel® WiFi Connection Utility from the Start menu (Start > All 
Programs > Intel PROSet Wireless > Intel(R) My WiFi Dashboard), or click the icon 

 in the notification area of the taskbar (or right-click and select Open Dashboard).
3.An initial welcome message will appear on the first run of the program (click “Don’t 
show this message again” to turn this off in future).

Figure D - 29
Intel® My WiFi 

Utility - Welcome
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Intel® My WiFi Interface

Figure D - 30
Intel® My WiFi 

Utility - Interface

Help

Your Computer

Configuration 
Options &

Wireless
ON/OFF

Preferences 
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Intel® My WiFi Help
Click the Help icon  in the dashboard to bring up the Help menu and select and
item from the Contents menu to obtain the help information.

Figure D - 31
Intel® My WiFi 
Utility - Help

Your

Help
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Preferences
Click the Options icon  and select Preferences to configure the options.

Figure D - 32
Intel® My WiFi 

Utility - Preferences

Your Computer

Help
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Hotspot
You can turn the computer into a hotspot to allow other devices to connect to it (and
any locally connected devices), and also (if available) the internet. 

1.Click the Hotspot icon  to turn the Hotspot on.
2.The Hotspot settings tab shows the SSID and password (you will need to enter this 
information when accessing the Hotspot from the client computer/device).
3.Click OK to close the Hotspot settings.

Figure D - 33
Intel® My WiFi 

Utility - Hotspot

H
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Finding Devices
You can find any Nearby Devices by clicking the Refresh button  in the main window. Click again at any
time to update the list. If a lot of devices are found they will be listed on multiple pages and you can use the left

 or right  buttons to turn the pages.

Sensitivity
The Sensitivity controls displays available devices based on their signal strength and proximity e.g decreasing
(-) the sensitivity lists only devices closest to the computer’s location.

Group Devices by Type
If you click Group by type it will list all devices according to their type in a folder group. Double-click on any
group folder to see the devices of that type listed. There are 12 possible device types available.

Search
If you want to search for a particular device by name then enter the device name in the Search field to return
results for devices matching the name of the device.
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Favorite Devices
The Favorite Devices tab is where you keep devices to which you connect most of-
ten, and this is particularly useful in environments where many devices are listed
nearby. A favorite device will display the icon .

To make any device a favorite just click to select it and select Add Favorite.

Figure D - 34
Intel® My WiFi 

Utility - Interface Device as Favorite
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Connect to a Device
1. Click the device you want to connect to, and click the connect icon .
2. An invitation will be sent to the target device.
3. The user must then accept the invitation.
4. After the invitation is accepted the connection will be made.
5. Use the Windows Network and Sharing Center to set permissions for viewing and sharing the resources on 

your computer with another connected computer.

Further Information
For information on how to block/unblock devices, setting Do Not Disturb, sharing an internet connection
and chat options see “Intel® My WiFi Help” on page D - 48.
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Bluetooth & WLAN Combo Module (Windows 7)
If your purchase option includes the Combination Wireless LAN & Bluetooth mod-
ule (either Intel® or 3rd Party) then install the driver as instructed from the appro-
priate page (see below). Use the On Screen Display button (see page D - 4) to toggle
power to the Combination Wireless LAN & Bluetooth module.

• For 3rd party Bluetooth combo modules see the information in “3rd Party 
Bluetooth (V4.0) Combo Driver Installation” on page D - 55 and “Standard 
Bluetooth Configuration in Windows 7” on page D - 57.

• For Intel Bluetooth combo modules see the installation procedure in “Intel 
Bluetooth Combo Driver Installation” on page D - 56 and “Standard Bluetooth 
Configuration in Windows 7” on page D - 57.


Bluetooth Data 

Transfer

Note that the transfer of
data between the com-
puter and a Bluetooth en-
abled device is supported
in one direction only (si-
multaneous data trans-
fer is not supported).
Therefore if you are copy-
ing a file from your com-
puter to a Bluetooth
enabled device, you will
not be able to copy a file
from the Bluetooth en-
abled device to your com-
puter until the file transfer
process from the comput-
er has been completed.


High Speed Bluetooth Data Transfer

The Combination Wireless LAN Bluetooth module supports high speed data transfer. How-
ever to achieve such transfer speeds, both devices must support high speed data transfer.

To obtain high speed data transfer make sure that the WLAN module is not turned off.
Check your Bluetooth compatible device’s documentation to confirm it supports high
speed data transfer.
D - 54 Bluetooth & WLAN Combo Module (Windows 7)



Windows 7

W
in

d
o

w
s 7
3rd Party Bluetooth (V4.0) Combo Driver Installation
Note this driver is required for the 3rd Party combo Bluetooth and WLAN module
(Bluetooth V4.0) only.

1. Before installing the driver make sure the Bluetooth module is powered 
on (use the On Screen Display button to toggle power to the module), then 
insert the Device Drivers & Utilities + User’s Manual disc into the DVD 
drive. If a Found New Hardware window appears, click Cancel in all win-
dows that appear, and then proceed to install the driver as below.

2. Click Option Drivers (button).
3. Click 3.Install Combo BT Driver > Yes.
4. Click Next (if a prompt appears to ask you to turn the Bluetooth power on, 

use the On Screen Display button to do so, otherwise the driver will not be 
installed).

5. Click Finish to restart the computer.
6. See “Standard Bluetooth Configuration in Windows 7” on page D - 57 for 

configuration instructions.


High Speed Bluetooth 

Data Transfer

The Combination Wire-
less LAN & Bluetooth
module supports high
speed data transfer. How-
ever to achieve such
transfer speeds, both de-
vices must support
high speed data trans-
fer.

To obtain high speed
data transfer make sure
that both the WLAN and
Bluetooth modules are
powered on.

Check your Bluetooth
compatible device’s doc-
umentation to confirm it
supports high speed data
transfer.
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Intel Bluetooth Combo Driver Installation
Note this driver is required only for the Intel combo Bluetooth and WLAN module
only.

1. Before installing the driver make sure the Bluetooth module is powered 
on (use the On Screen Display button), then insert the Device Drivers & Utili-
ties + User’s Manual disc into an attached DVD drive. If a Found New 
Hardware window appears, click Cancel in all windows that appear, and 
then proceed to install the driver as below.

2. Click Option Drivers (button).
3.Click 3.Install Combo BT Driver > Yes.
4. Click Next > Next.
5. Click the button to accept the license and click Next.
6. Click Next > Finish.
7. See “Standard Bluetooth Configuration in Windows 7” on page D - 57 for 

configuration instructions.


High Speed Bluetooth 

Data Transfer

The Combination Wire-
less LAN & Bluetooth
module supports high
speed data transfer. How-
ever to achieve such
transfer speeds, both de-
vices must support
high speed data trans-
fer.

To obtain high speed
data transfer make sure
that both the WLAN and
Bluetooth modules are
powered on.

Check your Bluetooth
compatible device’s doc-
umentation to confirm it
supports high speed data
transfer.
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Standard Bluetooth Configuration in Windows 7

Setup your Bluetooth Device so the Computer Can Find it
1. Turn your Bluetooth device (e.g. PDA, mobile phone etc.) on.
2. Make the device discoverable (to do this check your device documentation).

To Turn the Bluetooth Module On
1. Press the On Screen Display button to power on the Bluetooth module. 
2. A Bluetooth icon  will appear in the taskbar.
3. You can then do any of the following to access the Bluetooth Devices control

panel.

• Double-click the taskbar icon  to access the Bluetooth Devices control panel.

• Click/Right-click the taskbar icon  and choose an option from the menu.

Figure D - 35 - Bluetooth Devices & Click Icon Menu


Add a Device

Click Start, and click Con-
trol Panel and then click De-
vices and Printers
(Hardware and Sound).
Click Add a device to search
for any available Bluetooth
devices.

Bluetooth Module & 
Resuming From Sleep 

Mode

The Bluetooth module’s de-
fault state will be off after re-
suming from the Sleep
power-saving state. Use the
On Screen Display button
to power on the Bluetooth
module after the computer
resumes from Sleep.

Add a device

Click Taskbar Icon 
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To Add a Bluetooth Device
1. Access the Bluetooth Devices control panel and click Add a device.
2. Double-click the device you want to pair with the computer.

Figure D - 36 - Add a Device

3. On first connection the computer will provide you with a pairing code to be entered onto the device.


Pairing Options

If a device has been pre-
viously connected then
the pairing option menu
will appear when you at-
tempt subsequent con-
nections. You can choose
to have the computer cre-
ate a pairing code for you,
use the device’s existing
pairing code or you can
pair certain devices with-
out using a code.
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4. Enter the code into your Bluetooth enabled device and follow any on-screen instructions to complete the
pairing.

Figure D - 37 - Pairing Code Example
5. Windows will check to see if any drivers are required to complete the pairing. 
6. Follow any on-screen instructions on the computer if device drivers are required to be installed.
7. Click Close.

Figure D - 38 - Pairing Complete & Bluetooth Device Enabled


Pairing Codes

The example outlined here shows a connection to a mobile de-
vice. Other devices e.g. computers, may have a slightly different
connection procedure, and may require you to confirm a pairing
code is correct on both devices. Follow the on-screen instruc-
tions to complete the pairing.
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To Change Settings for the Bluetooth Device
1. Click the taskbar icon and select Show Bluetooth Devices.
2. Right-click on the device you want to change and click Properties to:

• Change the name of the device (click Bluetooth, type a new name and click OK).
• Enable/Disable a service (click Services, clear/tick the check box next to the service and click OK).

To Make your Computer Discoverable to Bluetooth Devices
1. Click the taskbar icon and select Open Settings.
2. Click Options, and make sure that Allow Bluetooth devices to find this computer check box (Discovery) 

has a tick inside it.
3. Make sure that the Alert me when a new Bluetooth device wants to connect check box (Connections) has 

a tick inside it, if you want to be notified when a Bluetooth device wants to connect.

Figure D - 39 - Bluetooth Settings - Options


Bluetooth Help

To get help on Bluetooth configuration
and settings, select Help and Support
from the Start menu. Type Bluetooth in
the Search Help box, and select an item
from the returned search results to get
more information.
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Bluetooth Connection Problems
If you are experiencing problems connecting to some Bluetooth devices (in particular certain mobile phones and
headsets) it maybe necessary to download and install the Windows Mobile Device Center software (for Win-
dows Vista and Windows 7). Go to the Microsoft website and search for the Microsoft Windows Device Center
Driver for Windows Vista (64-bit or 32-bit) and Windows 7 (64-bit or 32-bit), and then download the driver. 

1. Install the Microsoft Windows Device Center Driver as appropriate for your operating system.
2. Windows Vista will automatically configure the driver for you, however Windows 7 requires further configuration.
3. Make sure the Bluetooth device is powered on.
4. Go the Windows 7 control panel and double-click Device Manager (Hardware and Sound > Devices and 

Printers).
5. Bluetooth Peripheral Device(s) will be listed under Other Devices (note this will only be listed if you have 

connected, or tried to connect to, a Bluetooth device previously).

Figure D - 40 - Device Manager


Bluetooth Peripheral Devices

You will need to repeat the procedure
listed here for all Bluetooth Peripher-
al Devices listed under Other Devices
i.e. until there are no more Bluetooth
Peripheral Devices listed under this
menu heading.
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6. Right-click Bluetooth Peripheral Device and click on Update Driver Software.
7. Click Browse my computer for driver software.
8. Click Let Me pick from a list of device drivers on my computer.

Figure D - 41 - Browse my computer.../Let me pick from...
9. Select Bluetooth Radios from the list.

Figure D - 42 - Select Bluetooth Radios
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10. A list of drivers will appear with Manufacturer on one side and Model in the other. 
11. Choose Microsoft Corporation (make sure you choose the full name Microsoft Corporation and do not 

choose Microsoft - Note that you must have installed the Microsoft Windows Device Center Driver for 
Microsoft Corporation to appear in the list). 

12. Select Windows Mobile-based device support from the Model list.

Figure D - 43 - Select Device Driver
13. Click Next > Yes and the driver will install.
14. Click Close to complete the installation.

Make sure you select
Microsoft Corporation
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15. The Device Manager should now display the Windows Mobile-based device support under Bluetooth 
Radios.

16. You will need to repeat the process for any other Bluetooth Peripheral Devices listed under Other Devices.

Figure D - 44 - Device Manager - Bluetooth Radio
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Intel® Rapid Storage Technology
Install the Intel Rapid Storage Technology to support your SATA drive if set up in AHCI mode in the BIOS (see
“SATA Mode Selection (Advanced Menu)” on page 5 - 9).

IRST Driver Installation
1. Insert the Device Drivers & Utilities + User’s Manual disc into the DVD drive.
2. Click Option Drivers (button).
3. Click 4.Install IRST Driver > Yes.
4. Click (click the box to Install Intel® Control Center) to Next > Yes > Next > Next.
5. Click Finish to restart the computer (you will need to restart the computer again after it has rebooted).
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Intel® Rapid Start Technology Driver
Intel(R) Rapid Start Technology can resume power from Hibernation within 5 to 6 seconds and can remember
your computer's previous state with zero power.

System Requirements to support Intel® Rapid Start Technology:
• Rapid Start Technology should be enabled in the BIOS (see ““Intel(R) Rapid Start Technology (Advanced 

Menu)” on page 5 - 8).
• Intel Rapid Storage Technology software installed. 
• A Solid State Drive (SSD) with a minimum capacity of 18.6GB.

See overleaf for instructions on enabling Intel® Rapid Start Technology and see “Intel Smart Connect & In-
tel Rapid Start Technology” on page D - 78 for information on configuring Rapid Start and Smart Connect
Technology.
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Intel® Rapid Start Technology Configuration
1. Enable/disable Intel(R) Rapid Start Technology from the BIOS (see “Intel(R) 

Rapid Start Technology (Advanced Menu)” on page 5 - 8).
2. Go the Windows control panel and double-click Administrative Tools (System 

and Security)> Computer Management > Storage > Disk Management
3. Right-click the SSD and select Shrink Volume from the menu.

Figure D - 45
Computer 

Management 
(Shrink SSD 

Volume)

Shrink Volume
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4. Enter the figure, which should be equal to amount of system memory (RAM) in 
your computer, in “Enter the amount of space to shrink in MB”.

5. Click Shrink (any unallocated file space may be formatted for storage use).

Figure D - 46
Shrink Volume 

Size


Memory Size (Amount of Space to Shrink)

The figure entered in the “Enter the amount of space to shrink in MB” field above should be equal
to the amount of system memory in your computer. In the example above the system memory is 4GB
(1024MB * 4 = 4096GB). If you are unsure of your total system memory (RAM) then go to System
control panel (System and Security) and check Installed memory (RAM). The memory size will be dis-
played in GB so convert by multiplying the GB figure by 1024 to get the total in MB (e.g. 8GB =
8192MB).
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6. Click the Start menu and type “CMD” in the search box.
7. Click CMD from the found list.

8. Type “DISKPART”.
9. At the DISKPART command type “list disk”.

Figure D - 47
Search for CMD 

Prompt

Figure D - 48
Diskpart - List Disk
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10.Type “select disk #” (# is disk number where you want to create the store partition, 
so refer to the results obtained from "list disk" for exact disk number).

11.The message “Disk # is now the selected disk.” will appear.

12.Type “create partition primary”.
13.A “DiskPart succeeded in creating the specified partition.” message should 

appear.

Figure D - 49
Diskpart - Select 

Disk #

Figure D - 50
Diskpart - Create 

Partition
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14. Type “detail disk”.

15. Type “select Volume #” (# is volume of your storage partition so refer to results 
obtained from "detail disk" for the exact volume number).

16. The message “Volume # is now the selected volume.” will appear.

Figure D - 51
Diskpart - Detail 

Disk

Figure D - 52
Diskpart - Select 

Volume #
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17.Type “set id=84 override” (the id must be set to 84).

18.The message “DiskPart successfully set the partition ID.” will appear.
19.Close the CMD window.
20.Go the Windows control panel and double-click Administrative Tools (System 

and Security)> Computer Management > Storage > Disk Management.
21.The disk partition should read Healthy Hibernation Partition.

22.Restart the computer.

Figure D - 53
Diskpart - Set 
id=84 Override

Figure D - 54
Computer 

Management 
(Healthy 

Hibernation 
Partition) Healthy (Hibernation Partition)
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Intel® Rapid Start Technology Driver Installation
1. Insert the Device Drivers & Utilities + User’s Manual disc into the DVD drive.
2. Click Option Drivers (button).
3. Click 5.Install Rapid Start Driver > Yes.
4. Click Next > Next > Yes > Next > Next.
5. Click Finish to restart the computer.
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Intel® Smart Connect Technology
Intel® Smart Connect Technology periodically, and briefly, wakes the computer
from Sleep mode in order to update information for certain applications (e.g. to get
mail from Microsoft Outlook) as required. These updates can therefore be made
without having to turn the computer on, and applications will be up to date when the
computer resumes from Sleep mode (make sure that Intel Smart Connect Technol-
ogy is enabled in the BIOS - see “Intel Smart Connect Technology (Advanced
Menu)” on page 5 - 8). 

Note that the applications need to be on and running when the computer enters
Sleep mode in order to get updates.

Intel® Smart Connect Technology Driver Installation
1. Insert the Device Drivers & Utilities + User’s Manual disc into the DVD 

drive.
2. Click Option Drivers (button).
3. Click 6.Install ISCT Driver > Yes.
4. Click Next.
5. Click the button to accept the license agreement and click Next.
6. Click Next > Install > Finish.
7. Click Yes to restart the computer.


Intel® Smart Connect 
Technology System 

Requirements

Note that in order to sup-
port Intel® Smart Con-
nect Technology your
system will need to have
the item enabled in the
BIOS (see page 5 - 8).

In addition only the follow-
ing WLAN modules sup-
port this feature:

Intel® Centrino® Wire-
less-N 2230
Intel® Centrino® Wire-
less-N 135
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Intel® Smart Connect Technology Configuration
1. Access the Intel(R) Smart Connect Technology application from the Start menu.
2. Click Basic (tab) and adjust the slider to set the update frequency (note that the 

slider balances between “More Frequent Updates” and “More Battery Life”).
3. Note the sidebar warning about the use of Intel(R) Smart Connect Technology 

aboard aircraft and make sure your wireless LAN module is off during air travel.
4. In order to update any applications, they will need to be on and running when the 

computer enters Sleep mode.

Figure D - 55
iSCT Basic
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5. Click Advanced (tab) to access the Extended Power Savings settings.
6. Extended Power Savings allows you to set a time period during which the 

computer will update less often (e.g. at night while you are asleep or whenever you 
are at work).

7. Updates set during this time period will be performed every two hours, and this will 
override the settings selected in the Basic tab in order to conserve power 
consumption.

Figure D - 56
iSCT Advanced
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8. Click the Help tab and click Topics to access the main Help menu.


Intel WLAN Modules

If your purchase option
includes an Intel WLAN
module, (with Intel’s
PROSet Wireless Con-
nection Utility in-
stalled), Intel® Smart
Connect Technology
will search for WiFi net-
works around you that
you have previously ac-
cessed. 

If no known WiFi net-
works are found, your
computer will not update
again until it recognizes
a known WiFi network.

Figure D - 57
iSCT Help
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Intel Smart Connect & Intel Rapid Start Technology
Intel® Smart Connect Technology wakes the computer from Sleep mode in order
to update application information. Intel(R) Rapid Start Technology can resume
power from Hibernation within 5 to 6 seconds and can remember your computer's
previous state with zero power. Intel(R) Rapid Start Technology sends the com-
puter into Hibernate mode and skips the Sleep mode. Therefore if Rapid Start is en-
abled, Smart Connect will be unable to wake the system as Sleep mode has been
bypassed. In order to configure your system to run Smart Connect you will either
need to disable or delay the system from running Rapid Start.

Disabling or Delaying Rapid Start Technology
1. Click Start > All Programs > Intel > Intel(R) Rapid Start Technology Manager, or 

double-click the icon  in the notification area of the taskbar.
Figure D - 58

Intel® Rapid Start 
Technology 

Manager Access
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Intel® Wireless Display Application (Windows 7)
The Intel® Wireless Display Application (requires Intel® Centrino WLAN/
Combo module), in conjunction with a compatible video adapter (purchased sep-
arately), allows you to display the contents of the notebook display on another dis-
play (e.g. HDTV) without the need to have cables stretching across a room. You can
then play games, browse the internet, display videos or photo slide shows on your
TV/external display without using HDMI or A/V cables.

Before configuring the Intel® WiDi application you will need to set up your com-
patible adapter with your display/speakers. Connect the adapter using an HDMI or
A/V cable and turn on the display (or in the case of speakers connect them to the
wireless speaker adapter with the cables provided with the adapter), and then set the
display to the appropriate input channel (see the documentation supplied with your
compatible adapter for full details).


Compatible 

Adapters

For a list of compatible
display and audio adapt-
ers check the Intel web-
site, or your distributor/
supplier.
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Intel® WiDi Application Installation
1. Insert the Device Drivers & Utilities + User’s Manual disc into an attached DVD drive. 
2. Click Option Drivers (button).
3. Click 7.Install WiDi AP > Yes.
4. Click Next.
5. Click the button to accept the license and click Next.
6. Click Finish.
D - 80 Intel® Wireless Display Application (Windows 7)
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Intel® WiDi Application Configuration
1. Click Start > All Programs > Intel Corporation > Intel(R) Wireless Display > Intel(R) Wireless Display, or 

double click the icon  on the desktop.
2. Click I agree to the terms of this license (button).
3. The application will scan for any connected compatible adapters (or you can click the Scan for available 

adapters button to enable Intel My WiFi Technology).

Figure D - 59 - Intel® WiDi Scan
Intel® Wireless Display Application (Windows 7) D - 81
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4. Click to select any detected adapters, and click Connect.
5. The system will then prompt you to enter the 4-digit security code which will be displayed on the external TV 

Screen (or press the connect button on the wireless speaker adapter).
6. Enter the code for the video adapter and click Continue.

Figure D - 60 - Intel® WiDi Connect & Enter Security Code
D - 82 Intel® Wireless Display Application (Windows 7)
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7. You will then be prompted to enter a name for the video adapter and click Continue.
8. Click Finished to complete the setup.

Figure D - 61 - Intel® WiDi Connected


Test Audio Adapter

To verify a successful au-
dio connection (for Intel®
Wireless Music), select
the “Test your audio
connection” link or select
“Finished” to bypass the
test.

You can select “Play
Sample” to play an audio
test sample from your
adapter to the connected
speaker set.
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